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Safety Precautions

The following are general safety precautions that are not necessarily related to any specific part or procedure, and 
do not necessarily appear elsewhere in this publication. These precautions must be thoroughly understood and 
apply to all phases of operation and maintenance.

WARNING
Keep Away From Live Circuits

Operating Personnel must at all times observe general safety precautions. Do not 
replace components or make adjustments to the inside of the test equipment with the 

high voltage supply turned on. To avoid casualties, always remove power.

WARNING
Shock Hazard

Do not attempt to remove the RF transmission line while RF power is present.
Capacitors can store a dangerous electrical charge. Avoid contact with all system 
capacitors. If it is necessary to perform work near a system capacitor, be sure to 

discharge the capacitor through a low resistance.

WARNING
Do Not Service Or Adjust Alone

Under no circumstances should any person reach into an enclosure for the purpose of 
service or adjustment of equipment except in the presence of someone who is capable 

of rendering aid.

WARNING
Safety Earth Ground

An uninterruptible earth safety ground must be supplied from the main power source 
to test instruments. Grounding one conductor of a two conductor power cable is not 

sufficient protection. Serious injury or death can occur if this grounding is not properly 
supplied.

WARNING
Resuscitation

Personnel working with or near high voltages should be familiar with modern methods 
of resuscitation.

WARNING
Remove Power

Observe general safety precautions. Do not open the instrument with the power on.
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Safety Symbols

Note: Calls attention to supplemental information.

Caution Statements

The following equipment cautions appear in the text whenever the equipment is in danger of damage and are 
repeated here for emphasis.

See page 12

See page 12

See page 13. 

See page 14

WARNING
Warning notes call attention to a procedure, which if not correctly performed could 

result in personal injury.

CAUTION
Caution notes call attention to a procedure, which if not correctly performed could 

result in damage to the instrument.

The caution symbol appears on the equipment indicating there is 
important information in the instruction manual regarding that 
particular area.

CAUTION
Do not block airflow to fan or air vents.

Unit will overheat if the fan is not circulating air through the unit.

CAUTION
The Bird Diagnostic System is intended for indoor use only.
Outdoor use may cause permanent damage to the system.

CAUTION
Bending RF cables can cause damage. When routing RF cables, the minimum bend radius is 
0.5 inch (12.7 mm). Do not bend the cables more than the minimum bend radius. Failure to 

comply may result in permanent damage to the cable and reduced equipment 
performance.

CAUTION
Do not over tighten SMA connectors. 

Over tightening can deform the connectors and adversely impact system calibration. 
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Safety Statements

USAGE

ANY USE OF THIS INSTRUMENT IN A MANNER NOT SPECIFIED BY THE MANUFACTURER MAY 
IMPAIR THE INSTRUMENT’S SAFETY PROTECTION.

USO

EL USO DE ESTE INSTRUMENTO DE MANERA NO ESPECIFICADA POR EL FABRICANTE, PUEDE 
ANULAR LA PROTECCIÓN DE SEGURIDAD DEL INSTRUMENTO.

BENUTZUNG

WIRD DAS GERÄT AUF ANDERE WEISE VERWENDET ALS VOM HERSTELLER BESCHRIEBEN, 
KANN DIE GERÄTESICHERHEIT BEEINTRÄCHTIGT WERDEN.

UTILISATION

TOUTE UTILISATION DE CET INSTRUMENT QUI N’EST PAS EXPLICITEMENT PRÉVUE PAR LE 
FABRICANT PEUT ENDOMMAGER LE DISPOSITIF DE PROTECTION DE L’INSTRUMENT.

IMPIEGO

QUALORA QUESTO STRUMENTO VENISSE UTILIZZATO IN MODO DIVERSO DA COME 
SPECIFICATO DAL PRODUTTORE LA PROZIONE DI SICUREZZA POTREBBE VENIRNE 
COMPROMESSA.
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SERVICE

SERVICING INSTRUCTIONS ARE FOR USE BY SERVICE - TRAINED PERSONNEL ONLY. TO AVOID 
DANGEROUS ELECTRIC SHOCK, DO NOT PERFORM ANY SERVICING UNLESS QUALIFIED TO DO 
SO.

SERVICIO

LAS INSTRUCCIONES DE SERVICIO SON PARA USO EXCLUSIVO DEL PERSONAL DE SERVICIO 
CAPACITADO. PARA EVITAR EL PELIGRO DE DESCARGAS ELÉCTRICAS, NO REALICE NINGÚN 
SERVICIO A MENOS QUE ESTÉ CAPACITADO PARA HACERIO.

WARTUNG

ANWEISUNGEN FÜR DIE WARTUNG DES GERÄTES GELTEN NUR FÜR GESCHULTES 
FACHPERSONAL.
ZUR VERMEIDUNG GEFÄHRLICHE, ELEKTRISCHE SCHOCKS, SIND WARTUNGSARBEITEN 
AUSSCHLIEßLICH VON QUALIFIZIERTEM SERVICEPERSONAL DURCHZUFÜHREN.

ENTRENTIEN

L’EMPLOI DES INSTRUCTIONS D’ENTRETIEN DOIT ÊTRE RÉSERVÉ AU PERSONNEL FORMÉ AUX 
OPÉRATIONS D’ENTRETIEN. POUR PRÉVENIR UN CHOC ÉLECTRIQUE DANGEREUX, NE PAS 
EFFECTUER D’ENTRETIEN SI L’ON N’A PAS ÉTÉ QUALIFIÉ POUR CE FAIRE.

ASSISTENZA TECNICA

LE ISTRUZIONI RELATIVE ALL’ASSISTENZA SONO PREVISTE ESCLUSIVAMENTE PER IL 
PERSONALE OPPORTUNAMENTE ADDESTRATO. PER EVITARE PERICOLOSE SCOSSE 
ELETTRICHE NON EFFETTUARRE ALCUNA RIPARAZIONE A MENO CHE QUALIFICATI A FARLA.



Bird Diagnostic System

vi

About This Manual

This manual covers the operating and maintenance instructions for the following models:

Changes to this Manual

We have made every effort to ensure this manual is accurate. If you discover any errors, or if you have suggestions 
for improving this manual, please send your comments to our Solon, Ohio factory. This manual may be periodically 
updated. When inquiring about updates to this manual refer to the part number and revision on the title page.

Chapter Layout

Introduction — Introduces the external features and functions of the unit, equipment provided, and options. 
Installation — Provides information about connecting the instrument to your equipment.
User Interface Description — Descriptions of the options available on the User Interface screens
Operating Instructions — All instructions necessary to operate the equipment are contained in this chapter.
Maintenance — Parts lists and repair instructions are also in this chapter.

7001A900-2 7001A900-3
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Chapter 1 Introduction

Bird Diagnostic System (BDS)

The Bird Diagnostic System (BDS) is a broadband RF monitoring and diagnostic system designed to be used in 50 or 
non-50 ohm environments (See "Specifications" on page 70 for available bandwidths). The BDS consists of three 
components: 

 In-line RF sensor

 A receiver that processes the real-time sensor data

 A cable that connects the sensor to the receiver

Figure 1  Bird Diagnostic System

BDS Receiver 

The receiver converts the incoming analog signals to digital data and then processes the data and makes it available 
to the communication port. 
Receiver Inputs

 Voltage (Analog) - 12-bits sampled at 512 MSPS simultaneously with current to preserve the phase 
relationship.

 Current (Analog) - 12-bits sampled at 512 MSPS simultaneously with voltage to preserve the phase 
relationship.

 External Sync (Digital) - Reference for identifying pulse states.

Receiver Measurement Capabilities
The BDS receiver is intended for use in the following RF Power delivery systems:

 Continuous Wave (CW) - Power is steady state. Measurements are performed periodically.

 Pulse - Power is pulsed on and off. Measurements are enabled/disabled by external sync signal.

 Multi-Level Pulse - Power is stepped in multiple states. Amplitude and frequency of the carrier signal from 
each generator is varied in a repetitive fashion. Measurements are synchronized by an external sync signal 
and aggregated by state.

BDS
RECEIVER

BDS
SENSOR

CALIBRATED
CABLE
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Frequency Tracking Capabilities
The BDS receiver has the capability of tracking up to three fundamental frequencies. In addition, the receiver can 
track frequency harmonics and inter-modulation products. 

Note: Operating mode may affect the maximum number of frequency components the BDS receiver 
has the ability to track. 

The receiver is capable of monitoring a maximum 12 frequency components. The 12 frequency components may 
consist of a combination of the following:

Maximum of 3 fundamental frequencies. 
Up to 4 harmonic frequencies for each fundamental frequency (in addition to the fundamental). 
Up to 6 inter-modulation products. 

The BDS also has the capability to detect arc transients. 

Receiver Control/Communication

BDS Sensor

The BDS sensor, which consists of passive, temperature stable components, is inserted into an RF delivery system 
where it couples voltage and current signals and sends that data to the receiver through the cable assembly. The 
sensor is purchased separately based upon the specifications of the end user’s requirements.

BDS Options

The BDS is a system (consisting of a receiver, cable set, and a sensor), designed to measure the performance of an RF 
delivery system. The components of the BDS may be purchased individually or as a kit. 

Locked versus Unlocked

The BDS can be purchased locked or unlocked. The uncertainty specification of a BDS is affected by its designation as 
locked or unlocked. See Table 1, “BDS System Options,” on page 3.
Locked — A BDS is considered locked, when the receiver, cable, and sensor are calibrated for accuracy as a unit. 
when calibrated as a unit, the overall measurement uncertainty is reduced. See "Voltage, Current and Phase 
Measurement Characteristics" on page 73 for a table showing the measurement uncertainties for the BDS.
Unlocked  — A BDS is considered unlocked, when the components of the system are calibrated individually. While 
the BDS will still be a highly accurate measurement system, there is an increased measurement uncertainty as a 
result of independent calibrations. See "Voltage, Current and Phase Measurement Characteristics" on page 73 
for a table showing the measurement uncertainties for the BDS.

Model # Communication/
Control Interface Resource

7001A900-2 Ethernet  Graphical UI, Web UI

7001A900-3
Ethernet  Graphical UI, Web UI
RS-232  Measurement data only
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Table 1  BDS System Options

BDS Receiver Options

The BDS Receiver is available with the following options. If the BDS is purchased with an option, a license is issued in 
the form of an electronic file. The BDS’s WebUI is used for option license installation, see "Installing an Option 
License" on page 66.
Table 2  BDS Receiver Options

Systems Component Part Number

Unlocked

Receiver, with Ethernet 7001A900-2
Receiver, with Ethernet and Serial 7001A900-3

Cable 7001B040-5M
Sensor, Protruding Dielectric 7001A550-2

Sensor, Standard 7001A550-1-XXYYa

a. XXYY = RF connector options for input and output connectors

Locked

BDS2 Kit with Ethernet,
Protruding Dielectric Sensor 7001A500-1-2

BDS2 Kit with Ethernet,
Standard Sensor 7001A500-1-XXYYa

BDS Option Modes of Operation
Standard Tracking Spectral Search Time Domain

BDS Receiver 
with

no option
 

BDS Receiver 
with

Time Domain option
  
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BDS Operating Modes

BDS Receiver operating modes are:

 "Standard Tracking Mode" on page 4

 "Spectral Search Mode" on page 6

 "Time Domain Mode" on page 7

Standard Tracking Mode

There are three tracking options available in the Standard tracking mode: CW, Pulse, and Multi-Level Pulse.
The BDS reports voltage amplitude, current amplitude, and phase information as a data set for each specified 
fundamental frequency.

Example - Select 2 MHz as the first fundamental frequency (F1) and 13.56 MHz as the second funda-
mental frequency (F2), and specify two harmonics for F1 (H2 and H3) and one harmonic for F2 (H3), the 
results would be grouped as a set for each fundamental frequency as shown in the following table (note 
that H1 is the same as the fundamental frequency and that N represents the Nth data set).

CW Option
In the CW mode, the BDS collects voltage and current information for user specified fundamental and harmonic 
frequencies continuously. The fundamental frequencies are tracked to ensure peak signal measurements are 
captured. No external sync pulse is required for CW option.
Pulse Option
In the Pulse mode, the BDS collects voltage and current information for user specified fundamental and harmonic 
frequencies only during the duration of the external sync pulse. The fundamental frequencies are tracked to ensure 
peak signal measurements are captured during the pulse period. 

Figure 2  Pulse Mode

Dataset Fundamental Harmonic Data
1 F1 (2MHz) H1 (F1) 2.0MHz, V,I,phase

F1 (2MHz) H2 (2F1) 4.0MHz, V,I,phase
F1 (2MHz) H3 (3F1) 6.0MHz, V,I,phase
F2 (13.56MHz) H1 (F2) 13.56MHz, V,I,phase
F2 (13.56MHz) H3 (3F2) 40.68MHz, V,I,phase

… … … …
N F1 (2MHz) H1 (F1) 2.0MHz, V,I,phase

F1 (2MHz) H2 (2F1) 4.0MHz, V,I,phase
F1 (2MHz) H3 (3F1) 6.0MHz, V,I,phase
F2 (13.56MHz) H1 (F2) 13.56MHz, V,I,phase
F2 (13.56MHz) H3 (3F2) 40.68MHz, V,I,phase

Measurement
Duration

External
Sync Pulse
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Multi-Level Pulse Option
In the Multi-Level Pulse mode, the BDS collects voltage and current information for user specified fundamental and 
harmonic frequencies for up to four pulse levels starting at the rising edge of the sync pulse. The fundamental 
frequencies are tracked to ensure peak signal measurements are captured during the pulse period. 

Figure 3  Multi-Level Pulse Mode

When Multi-Level Pulse is selected for Standard Tracking Mode a number of options must be defined for proper 
operation:

 Number of States - This option is used to define the number of states (pulse levels) used during 
each frame (Pulse Period). 
 Delay - A time delay, from the rising edge of the sync pulse, must be entered for each state, this 
provides the receiver the information required to begin measurement of each state.
 Duration - The length of time (pulse width) of each state must be defined, for each state. The dura-
tion value provides the information the receiver needs to measure the full width of each state. 
 Number of Frames - If a state duration is less than approximately 25 µsec, entering the number of 
frames (pulse periods) for a state, allows the receiver to “focus” on tracking a single state for the 
selected number of frames to “lock” onto the frequency. 
 Pulse Period - The length of time (period) of the entire frame of multi-level states. This should 
match the period of the external sync pulse.

Duration

Duration
State 4

Duration

Duration

Sync Event

External
Sync Pulse
(Sync to 
  Rising Edge)

State 3

State 2

State 1

State 1 Delay 

State 2 Delay 

State 3 Delay 

State 4 Delay 

One Frame
(Pulse Period)
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Spectral Search Mode

The Spectral Search (Sweep) Mode is used to get an overall view of the spectral components in a given frequency 
band. It sweeps across a frequency band, from start to stop frequency, displaying the amplitude at each frequency 
step. 
The user defines the frequency band by entering a start frequency, a stop frequency, and a step increment. The BDS 
produces power spectral density information for each detected frequency in the band in accordance with the step 
increment value (Figure 4).

Figure 4  Spectral Search (Sweep) Operating Mode
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Time Domain Mode

Note: Time Domain mode is an optional mode requiring an additional license, see "BDS Receiver 
Options" on page 3.

The BDS Time Domain mode allows unprecedented visibility into the shape of pulsed RF waveforms in the non 50-
Ohm environment. Very similar to an oscilloscope, the BDS will display a one-shot, triggered view of the pulse 
envelope. Very different from an oscilloscope, the BDS will display the waveform in voltage, current, phase, power, 
or impedance to the fully-specified accuracy of the system.
Key features:

 Time resolution of 500 ns

 Configurable time scale from 10 us to 10 ms

 Trace averaging

 Trigger on voltage or current waveform, rising or falling edge

 External trigger available

 Advanced trigger settings, including upper and lower thresholds and hold off

 Adjustable pre- and post-trigger buffer from 5% to 95%

Figure 5  Time Domain Mode
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Transient Detection

The BDS has the ability to locate and report transient events. The user can define the parameters of what a transient 
may look like in their system, specifying transient length, and impulse change in dB. This feature is available in both 
Standard Tracking and Spectral Search modes.
Figure 6 shows a typical transient detection plot recreated from Transient Detect CSV file, see "Viewing Captured 
Data Using MS Excel" on page 60.

Figure 6  Typical Transient Detection Image
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Connectors, Controls and Indicators

Figure 7  BDS II Front Panel

Item Name Description
1 Sensor Data 

Serial Port Sensor temperature / data connector (DB-9), male

2  Sensor RF Input 
Current Current sensor connector

3 Sensor RF Input 
Voltage Voltage sensor connector

4 EtherCAT - IN EtherCAT control network input port
5 EtherCAT - OUT EtherCAT control network output port
6 Link/Activity

(Green)
EtherCAT OUT

7 ERROR
(Red) EtherCAT

8 RUN
(Green) EtherCAT

9 Link/Activity
(Green) EtherCAT IN

10 Sensor Status
(Orange, Green)

Illuminated green when cable and sensor are connected and ready for 
calibrated measurements. See "Status LEDs" on page 41.

11 Ready Status
(Orange, Green)

Illuminated orange during receiver initialization. Illuminated green when 
receiver is ready to measure. See "Status LEDs" on page 41.

12 Power Status
(Green) Illuminated green when power is applied. See "Status LEDs" on page 41.

13 RS-232 Connector used for serial (RS-232) data acquisition. 9-pin D-sub, female.
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Figure 8  BDS II Rear Panel

Item Name Description
1 RATE Device Net DeviceNet baud rate switch
2  DeviceNet 

Interface 
Connector

DeviceNet network connector used for control via a DeviceNet 
network.

3 SYNC Input Sync input used for pulse and multi-level pulse operation.
4 ETHERNET Ethernet Connection
5 Power Input BDS Power Supply connector, 15 VDC , 2.5 A
6 Power Switch Rocker Switch used to apply or remove power to the BDS.
7 Reset 

Pushbutton Resets the BDS to factory default settings.

8 Device Address 
Switches DeviceNet/EtherCAT address switches.

9 Module Status
(Red, Green) DeviceNet status LED.

10 Network Status
(Red, Green) DeviceNet status LED.
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Theory of Operation

The Bird Diagnostic System (BDS) is a real-time RF measurement system that consists of a sensor, a sensor cable, and 
a receiver. Each component of the BDS (sensor, sensor cable, receiver) is calibrated separately and contains its own 
calibration constants which permits interchangeability without recalibration. A sensor, sensor cable, or receiver can 
be replaced with minimal loss of accuracy.
The sensor is mounted in the host system’s RF delivery system where it simultaneously measures magnitude and 
phase of both voltage and current and sends the data to the receiver. 
The receiver processes the sensor data and makes it available to the communication ports. The receiver consists of 
RF input conditioning circuits, A/D converters, a high-speed signal processor, and input / output connectors 
(Figure 9 on page 11).
The A/D converters convert the analog RF signal to digital information for processing; the high-speed signal 
processor converts the signal from the time domain to the frequency domain while maintaining the correct phase 
relationship of each harmonic to its fundamental frequency.
The output of the BDS contains information about the RF including up to three fundamental frequencies (amplitude 
of both voltage and current and their phase for each fundamental frequency) and up to 4 harmonics (amplitude of 
both voltage and current and their phase for each harmonic, and also the phase relationship of each harmonic to 
the voltage component of its specific fundamental frequency). With this data set (voltage, current, and phase), 
power ( ) and impedance ( ) can be determined for each fundamental and harmonic 
frequency.
Users can choose the number of fundamental frequencies (up to three) and associated harmonics (up to 4) that are 
acquired and processed. Fundamental frequencies are processed in parallel channels, choosing multiple 
fundamentals will not impact processing time. See "Specifications" on page 70.
The host system can communicate with the BDS receiver through any of the methods outlined in "Receiver Control/
Communication" on page 2. 

Figure 9  Bird Diagnostic System Block Diagram

p v i cos= Z v i =
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Chapter 2 Installation

Unpacking and Inspection

1. Carefully inspect shipping container for signs of damage. 
 If the shipping container is damaged, do not unpack the unit. Immediately notify the shipping carrier and 

Bird Technologies.
 If the shipping container is not damaged, unpack the unit. Save shipping materials for repackaging.

2. Inspect unit for visual signs of damage. 
Note: If there is damage, immediately notify the shipping carrier and Bird Technologies.

Installing the Receiver

The receiver has a cooling fan inside and air vents on both ends of the case. For proper operation, be sure to install 
the receiver in a location that permits free air flow around and through the unit (Figure 10).

Figure 10  Receiver Air Flow Path

1. Place the receiver in a suitable location within cable length of the sensor.
2. Secure the receiver in place using two screws (Figure 11).

The mounting surface may be any material capable of supporting the receiver weight.

CAUTION
Do not block airflow to fan or air vents.

Unit will overheat if the fan is not circulating air through the unit.

CAUTION
The Bird Diagnostic System is intended for indoor use only.
Outdoor use may cause permanent damage to the system.
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Figure 11  BDS Receiver Mounting

Installing the Sensor

Note: Step 1 and 2 describe RF connections for a standard BDS Sensor with QC-connectors, customer 
specific requirements may effect sensor configuration and RF connections may be different. 

1. Connect the sensor RF In connector to the feed side of the host RF source cable. See Figure 12.
2. Connect the sensor RF Out connector the load side of the host RF source cable.

Figure 12  Sensor Cable Connections

Note: Figure 12 shows a standard BDS sensor equipped with QC-connectors for connecting to the RF 
delivery path. Other sensor versions have been developed to accommodate different types of RF input 
and output connections. In spite of these different form-factors, all sensors are equipped with the same 
voltage, current and temperature/data connectors for interfacing to the BDS Receiver. 

CAUTION
Bending RF cables can cause damage. When routing RF cables, the minimum bend 
radius is 0.5 inch (12.7 mm). Do not bend the cables more than the minimum bend 
radius. Failure to comply may result in permanent damage to the cable and reduced 

equipment performance.

Item Description
1 RF output connector
2 RF input connector
3 Current connector, SMA standard polarity
4 Temperature / data connector, 7 pin
5 Voltage connector, SMA reverse polarity

2

1

3

4

5
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Connecting the Sensor and Receiver Cables

1. Connect the current and voltage cables to the sensor (Figure 12 on page 13). 
Torque the SMA connectors to 4.5 in-lb (0.5 Nm).

Note: The SMA connector on the current sensor cable has a standard center conductor and the SMA 
connector on the voltage sensor cable has a reverse polarity center conductor.

2. Connect the temperature/data cable to the sensor.
3. Connect the current and voltage data cables to the receiver (Figure 13 on page 14). 

Torque the SMA connectors to 4.5 in-lb (0.5 Nm).
4. Connect the temperature / data cable to the receiver.
5. Connect receiver to external communications/control system.

a. If required, connect Ethernet cable to receiver’s Ethernet port (rear panel).
b. If required, connect cable to RS-232 connector (front panel), see "RS-232 Serial Control" on page 78 

for information about RS-232 setup/control.
6. Connect the power supply to the power connector. 
7. Apply power to the receiver (rear panel power switch) and verify that the LEDs on the receiver light. See "Status 

LEDs" on page 41 for a description of the Status LEDs operation. See "Connectors, Controls and Indicators" 
on page 9 for a description of all of the receiver’s LED indicators.

Figure 13  Receiver Cable Connections from Sensor

CAUTION
Do not over tighten SMA connectors. 

Over tightening can deform the connectors and adversely impact system calibration. 

Item Description
1 Voltage sensor connector
2 Current sensor connector
3 Sensor temperature / data connector (DB-9)
4 RS-232 Connector
5 EtherCAT connector
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Installing the BDS Graphical User Interface Application

1. Run 7001A992-X_BDS2GUI_setup-X.exe.
Note: This will create a shortcut under the start menu folder “Start->All Programs->Bird->BDS2 GUI.”

2. Copy the shortcut onto the PC’s desktop (optional).

Installing a BDS Receiver Option License

Options are available to extend the functionality of the BDS Receiver. An option license must be installed on the BDS 
receiver to activate a purchased option. The license is installed using the BDS Receiver’s Web User Interface, see 
"Installing an Option License" on page 66.
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Chapter 3 User Interface Description

BDS Ethernet Interfaces

There are two BDS Receiver user interfaces, the BDS Web UI and the BDS GUI.
BDS Web UI — The Web UI is used to manage the BDS Receiver’s firmware, licenses, IP address, time settings, 
and login credentials. The Web UI is accessed via the PCs web browser, see Web User Interface on page 16.
BDS GUI — The BDS GUI is an application that is installed on the PC. The BDS GUI is used to operate and control 
the BDS receiver’s measurement capabilities, see Graphical User Interface on page 22.

Figure 14  BDS Ethernet Connection

Web User Interface

The Web UI is accessed using a web browser, by entering the BDS’s IP address in the web browser. 
BDS Receiver Default IP Address: 192.168.0.151
Default Login: admin
Default Password: admin
When initially accessed the BDS homepage displays the BDS hardware serial numbers and calibration dates as well 
as software versions. See Figure 15 on page 17.
Status indicators at the bottom of the Web UI match the status indicators on the front panel of the BDS II, see 
Connectors, Controls and Indicators on page 9.
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Figure 15  Web UI Homepage

Web UI Login

To display the Login screen, click the Login button on the left side of the Web UI screen. Enter the Login and 
password to access the BDS Receiver’s configuration utilities.
Default Login: admin
Default Password: admin

Figure 16  Web UI Login Screen

After login is successful, an option menu is displayed. See Figure 17. Each menu is explained in the following 
sections.

Figure 17  Web UI Option Menu
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Setup

The setup menu provides the tools for changing the BDS receiver’s IP Address and the option of configuring a time 
server.
Network Settings
The BDS receiver is capable of operating with a static IP address or set to be dynamically assigned an IP address by a 
DHCP server. When set to static IP, the network settings tab allows the user to change the IP address, subnet mask, 
and the gateway. 

Note: DHCP should only be used if you are experienced in determining the IP address assigned by a 
DHCP server, or have configured the DHCP server to assign the BDS Receiver a specific IP address.

The factory default IP settings are shown in Figure 18. 
Click Save button to save changes to network settings. The BDS Receiver power must be cycled for the new 
network settings to take effect. See Changing BDS Receiver’s IP Address on page 64.

Figure 18  Network Settings Tab

Time Settings
The BDS receiver internal time may be set manually or the BDS receiver can be set to operate using an NTP server. 
See Figure 19 on page 18. 
To configure the BDS to use an NTP Server, select the Enable Network Time Protocol check box, then enter the NTP 
Server IP address or Domain name.
To manually update the time settings, select the Update Time check box, select the correct month, click on the day 
within the calendar, and enter the correct time of day in 24 hour format.
Click Save button to save changes to time settings. The BDS Receiver power must be cycled for the new time 
settings to take effect. See Update BDS Receiver’s Time Setting on page 65.

Figure 19  Time Settings Tab
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System Settings
The System settings tab can be used to turn on and off internal case lighting or do a soft reboot of the BDS Receiver. 
See Figure 20 on page 19.

Figure 20  System Settings Menu

Security

The Security menu allows the user to change the password. The password must be Alpha numeric value between 5-
12 characters. The new password must be entered twice and the two entries must match.
Default Password: admin
Click Change button to save changes to the password.

Figure 21  Security Menu

Measurement

Averaging Menu

Figure 22  Averaging Menu

Enable Data Averaging — Enables/Disables data averaging.
Default Value: Unchecked (averaging disabled)
Averaging Mode — This field is read-only. The averaging mode is always set to "Fixed (Simple)". 
"Fixed" averaging means that measurements are accumulated before computing an average. Once the averaging 
window is full, an average is computed and the measurement is reported.
Default Value: Fixed (Simple)
Avg Window Size — The number of measurements to accumulate before computing an average. 
Default Value: 0. Valid Range is 0 to 16.
Refresh — Reads the current settings from the BDS.
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Save — Applies the changes to the BDS. A system reboot is required.
Transient Detection Menu

Figure 23  Transient Detection Menu

Enable Transient Detection — Enables/Disables Transient Detection.
Default Value: Unchecked (Transient Detection disabled)
Ref Frequency — The Lowest Frequency is used to specify the lowest frequency being generated in the system 
where the BDS sensor is installed. This may correspond to the lowest frequency selected on the Frequency Selection 
screen, but is not required. Changes to this setting will update the acceptable range for the Sample Rate.
Sample Rate: — Peak detector sample rate, down-sampled from the actual ADC sample rate. Range is 25 ns (40 
MHz) to 500 us (2 kHz).

Note: The sample rate (time) should be set to longer than the period of the lowest expected input 
frequency to avoid oversampling of the input signals and generating false-positive transient events.

Length — The maximum time given for the trailing edge of a transient event "pulse" to occur in. An event must 
meet the power threshold condition for less than the specified time for it to be declared a transient event. The 
length is based on the sample rate. Range is 250 ns (for a 25 ns sample rate) to 500 ms (for a 500 us sample rate).
Trigger Delay — The percentage of the circular buffer to report after the falling edge of the transient event. The 
delay equates to a time based on the sample rate. 
Default Value: 50%. Range is 0 to 100%.
Min ADC Level — The minimum power level required to accept a transient event. This parameter is intended to 
prevent spurious event detected in noise. The value is entered as a percentage of ADC full-scale. 
Default Value: 12%. Range is 2 to 12%.
Power Threshold — The power level given for the transient "pulse" to cross, either as an increase (positive edge) 
or decrease (negative edge) in input signal strength.
Default Value: 3 dB. Level options include: 6 dB, 3 dB, 2 dB, or 1 dB.
Report events when detected on — A dropdown list containing the following event reporting options:

voltage or current channel. Report a transient detected on either the voltage or current channel.
voltage channel only. Report a transient detected on the voltage channel only.
current channel only. Report a transient detected on the current channel only.
both voltage and current channels (overlap). Report a transient detected on both the voltage and current 
channels within the same detection window of time (given by “Length” field).
Default Value: both voltage and current channels (overlap).

Refresh — Reads the current settings from the BDS.
Save — Applies the changes to the BDS. A system reset is required.
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Updates

The Updates menu is used for installing BDS Receiver Firmware updates, see Installing BDS Receiver Firmware 
Update on page 68.

Figure 24  Firmware Update Menu

License

The License Menu is used for installing BDS Receiver options. See Installing an Option License on page 66. See BDS 
Receiver Options on page 3.

Figure 25  License Installation Menu
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Graphical User Interface

The BDS 2 GUI is used to configure the BDS receiver and obtain measurement data from the system. 
There are three modes of operation: Standard Tracking, Spectral Search, and Time Domain. In addition, the BDS 
provides arc/transient detection capability that is available in Standard Tracking and Spectral Search modes. 
The BDS accurately measures voltage (V), current (I) and phase (P) in Standard Tracking, Spectral Search, and Time 
Domain operating modes. The BDS GUI uses these three basic parameters to derive other quantities such as power 
and impedance.

Note: The available frequency ranges will vary depending on the attached sensor, see Specifications 
on page 70.

The following GUI Descriptions are divided into these sections:

 Menu Bar  on page 22

 Toolbars  on page 26

 Status Bars  on page 27

Menu Bar

File Menu
Provides standard file operations for opening and saving BDS Documents.
New — Creates a new BDS document. 

Note: The new document will inherit the properties of the previous document, including measurement 
and scan options.

Close — Closes the active document. 
Note: This will stop data acquisition (if running).

File Options — Allows the user to configure file naming and autosave function. See File Options Dialog Box on 
page 25.
Save — Saves the active BDS document using previously selected name in CSV format. If the document has not 
been saved previously the Save As dialog box will open.

Note: This will stop data acquisition (if running).
Save As… — Opens the Save As dialog box, allowing the active document to be named and the file location to be 
selected. Saves the active BDS document in CSV format. See Figure 26.

Note: This will stop data acquisition (if running). 

Figure 26  Save As Menu Option

Save Setup — Opens the Save As dialog box allowing the current BDS configuration to be named and the file 
location to be selected. Saves the current BDS configuration in a REG format.
Recall Setup — Opens the Open dialog box allowing a BDS configuration (reg file) to be selected and imported. 
Imports a saved BDS configuration file.
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Figure 27  Save/Recall Setup Menu Options

Exit — Closes the BDS GUI application. 
Note: Automatically stops data acquisition and disconnects from the BDS receiver.

Connection Menu
Open — Establishes a connection to the BDS receiver.
Close — Closes the current connection to the BDS receiver.
New… — Displays the “New Connection” dialog box. See New Connection Dialog Box on page 26.
Mode Menu
Offers menu items for configuring and operating in either Tracking Mode or Spectral Search Mode. This menu is 
context-sensitive to the currently active mode (Tracking or Spectral Search).
Start Free Run (TRK) — Starts an acquisition in Tracking Mode (only available in Tracking mode).
Start Spectral Search (SP) — Starts an acquisition in Spectral Search Mode (only available in Spectral Search 
mode).
Start Time Domain (TD) — Starts an acquisition in Time Domain Mode (only available in Time Domain mode).
Start Trigger — Starts an acquisition based on an event trigger.
Stop Acquisition — Stops data acquisition.
Read-only Mode — Only one computer should be in control of the BDS receiver. When a second computer is 
connected to the BDS receiver, Read-Only mode should be selected on one of the computers. Read-Only mode can 
also be used to connect to the BDS receiver without changing any of its current configuration.
Switch Mode — 

Tracking Mode (TRK) — Changes the active mode to Tracking Mode. See Standard Tracking 
Mode on page 4. 

Spectral Search Mode (SP) — Changes the active mode to Spectral Search (Sweep) Mode. 
See Spectral Search Mode on page 6.

Time Domain Mode (TD) — Changes the active mode to Time Domain Mode. See Time 
Domain Mode on page 7. 
Time Domain Mode is a BDS Receiver option, see BDS Receiver Options on page 3.

Switch FPGA — When a license is purchased for a BDS receiver option additional FPGA images may be available 
to implement the option.

Standard FPGA — The Standard FPGA is supplied with the standard BDS receiver, with this 
FPGA selected the BDS is capable of operating in Standard Tracking and Spectral Search modes.

Time Domain FPGA — The Time Domain FPGA is supplied with the BDS receiver Time 
Domain option, with this FPGA selected the BDS is capable of operating in Standard Tracking, 
Spectral Search, and Time Domain modes.

Alerts... — Displays the Alerts dialog box which contains a list of alerts generated by the BDS system informing the 
user of system errors.
Gain Ctrl… — Displays the “Gain Control” dialog box, providing control of the receiver attenuator settings.
Options… — Displays the options dialog for the active mode.
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View Menu
Offers menu items for selecting a new view of a BDS document, configuring a view, or showing toolbars. The menu is 
context-sensitive to the currently active mode (Tracking or Spectral Search).
Standard Tracking Mode View Menu Items — 

Table (TRK) — Displays the document data in tabular format.

Time Plot (TRK) — Displays the document data plotted on a graph over time. 

Smith Chart — Displays the active document data in a Smith Chart.

View Dataset (TRK)… — Displays the “Dataset Number” dialog, allowing the user to show 
data for a single measurement in the table view.

Spectral Search Mode View Menu Items — 
Peaks (SP) — Displays a table of peaks that have been located in the sweep data.

Sweep (SP) — Displays amplitude over frequency.

Markers… — Displays the “Markers” dialog, allowing the user to enable/disable markers and 
set their positions on the sweep graph. 

Time Domain Mode View Menu Items — 
Markers… — Displays the “Markers” dialog, allowing the user to enable/disable markers and set their 

positions on the sweep graph. 
View Menu Items Shared by all Operating Modes — 

Toolbars — Display or hide the various toolbars.

Status Bar — Display or hide the main status bar on the active BDS document.

Graph Options… — 
 In Standard Tracking Mode: 

In Table View, opens the “Display Options” dialog. See Standard Tracking Mode 
Configuration on page 28.
In Time Plot View, opens Time Plot Display Options, see Time Plot Display Options on 
page 50.
In Smith Chart View, opens the Smith Chart Display Options, see Smith Chart Display 
Options on page 51.

 In Spectral Search Mode, opens the Mode Configuration Dialog. See Spectral Search (Sweep) 
Mode Options on page 36.
 In Time Domain Mode, opens the View Time Domain Options dialog. See Using Time Domain 
Mode on page 55.

Window Menu
Presents standard window menu options.
New Window — Creates a new View window from the active window.
Cascade — Aligns windows on top of one another.
Tile — Aligns windows in a tile pattern so that no windows overlap.
Arrange Icons — Not Used
Active Window — List of all open BDS documents is displayed, a check mark indicates the active document 
window.
Tools
Supplemental applets.
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Help Menu
About — Displays the “About” dialog, showing the application version and date information.

File Options Dialog Box

This option is on the File Menu menu. The BDS GUI can be configured to automatically save data at the end of a 
data acquisition. The auto-save options allows specifying the folder where the data is saved and also the file format 
to save it in. The file naming options are used to produce consistent file names that have a unique time stamp and 
run number. 

Note: File naming is required for auto-save.

Figure 28  File Options Dialog

Customizing Output Parameters — If the “Customize Output Parameters” checkbox is checked, the 
measurement parameters saved to a CSV file can be customized.
Clicking the “Options…” button will display a dialog (see Figure 29 on page 25) allowing the user to select the 
output parameters saved.

Figure 29  Custom Output Parameters Dialog

Use the Add >> and Remove << buttons to make customizations. Once ready, click the OK button.
Click the “Apply” button on the File Options page to accept the changes. This will commit the settings to the system 
registry to be used for subsequent launches of the BDSGUI.
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New Connection Dialog Box

The BDS GUI communicates with the receiver over Ethernet. In order to establish a connection to the BDS receiver 
you first need to make sure that the receiver and PC are on the same subnet, see Configuring PC Network Settings 
to BDS Subnet on page 42.

Figure 30  Connection Dialog

Address — The IP address or host name of the BDS receiver. The Default IP address is 192.168.0.151.
Port — The TCP/IP socket port (always 10050).
Reconnection — Select this checkbox to have the BDS GUI automatically reconnect when it loses connection with 
the receiver or if a connection fails.
Time Interval — The time in seconds to wait before the next reconnection attempt is made.
Connect button — Establishes a connection with the receiver at the given address. Closes the dialog and saves 
the settings to the system registry. 
Cancel button — Exits the dialog without applying the connection.

Toolbars

Toolbar icons are described from left to right.
Standard

New — Creates a new BDS document. 
Note: The new document will inherit the properties of the previous document, including measurement 
and scan options.

Save — Saves the active BDS document using previously selected name in CSV format. If the document has not 
been saved previously the Save As dialog box will open.

Note: This will stop data acquisition (if running).
Connection

Connect — The green button opens a connection to the BDS receiver.
Disconnect — The red button closes the connection to the BDS receiver.
Scan (Acquisition)

Start Button — Starts a new data acquisition using the currently selected method (Free Run, Trigger, or Sweep). 
The acquisition method may be changed using the drop-down arrow, acquisition will begin when a new method is 
selected from the drop down list.

Note: This has the same functionality as the “Mode->Start” menu items.
Stop Button — Stops data acquisition.

Note: This has the same functionality as the “Mode->Stop Acquisition” menu item.
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Graph (View)

Table — Displays the active BDS document data in tabular format.
Time Plot — Displays the active BDS document data plotted on a graph over time. 

Note: That this will display a “Sweep View” if in Spectral Search mode.
Smith Chart — Displays the active BDS document data as a Smith chart. Smith chart data is plotted normalized to 
50 Ohms. 

Note: This view does not apply while in Spectral Search mode.

Options

Standard Tracking Mode Options — Red reticule icon displays the Standard Tracking Mode Configuration 
dialog box.

Note: This has the same functionality as the “Mode->Options...” menu item.
Spectral Search Mode Options — Broom icon displays the Spectral Search (Sweep) Mode Configuration dialog 
box.

Note: This has the same functionality as the “Mode->Options...” menu item.
Time Domain Mode Options — Pulse icon displays the View Time Domain Options dialog.

Note: This has the same functionality as the “Mode->Options...” menu item.
Gain Control — Displays the Gain Control dialog box.
Alerts — Displays the Alerts dialog box.

Note: This has the same functionality as the “Mode->Alerts...” menu item.

Cycle

Least Recent — Displays the least recent data set.
Previous — Displays the previous data set.
Next — Displays the next data set.
Most Recent — Displays the most recent data set.

Status Bars

Main Window
The main Window status bar is a standard Windows status bar displaying a status message (to the left). 
On the right side this status bar, connection status, input overload conditions, and an alert indicator are displayed. 

Connection — Displays “CONNECTED” when the BDS GUI is connected to the BDS receiver. “DISCONNECTED” is 
displayed when the BDS receiver is disconnected. 
Overload — Displays “OVERLOAD” when and overload condition is detected on the voltage and/or current 
channel. Empty if no overload condition is detected.
Alert — Displays “ALERT!” if any alerts have occurred, will be displayed until all alerts have been cleared in the 
Alerts dialog box.
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BDS Document 

Each document window has its own status bar. The document status bar has six indicator fields (from left to right):
Scan — Displays “SCAN” if the document is collecting data from the BDS. Displays “IDLE” when not collecting.
Scan Mode — Displays the current scan mode for the document – “FREE”, “TRIG-XXX”, or “SWEEP”.
Continuous — Displays “CONT” while collecting data in “Continuous Scan” mode.
Averaging — Displays “AVG X” if averaging is enabled, “X” is a number representing the averaging window size 
selected when averaging was enabled. Displays “AVG OFF” if averaging is disabled. 
De-embedding — Displays “DEEMBED” if impedance de-embedding is enabled for this view. Empty if impedance 
de-embedding is disabled.
Cursor Coordinates — Displays the X,Y coordinates of the cursor within the BDS Document window.

Mode Configuration Dialog Boxes

Each mode, when selected, has a configuration dialog box. Each dialog box contains multiple tabs allowing the user 
a full range of options for configuring the BDS Receiver.

 Standard Tracking Mode Configuration on page 28

 Spectral Search (Sweep) Mode Options on page 36

 Time Domain Mode Options on page 39

Standard Tracking Mode Configuration

Frequency Selection Tab
The Frequency Selection tab is used to define one or more frequencies for the BDS to monitor while in Standard 
Tracking Mode. 

Note: All options, including harmonic and intermod selection, tolerance, and detection filter, apply to 
a fundamental frequency.
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Figure 31  Frequency Selection Dialog

Single Frequency — Allows selection of a single frequency, when a frequency is entered using this option, any 
previously selected frequencies are removed from the Selected Frequencies list
Fundamental Groups — Drop-down menu contains the fundamentals available for selection.
Fundamental — Select from the list of fundamental frequencies derived from the fundamental group selected. 

Note: Select all other options for the fundamental before adding it to the list of selected frequencies. 
Options include harmonic selection, intermod selection, and tolerance settings.

H1 through H5 — Select harmonics reported for the fundamental.
F2 Frequency — Select another fundamental from the list to use as the “F2” frequency in an intermodulation 
product. 

Note: The F2 frequency must have already been added to the selected frequencies list. 

Note: An intermod is a combination of two frequencies in the form: IMD = F1+nF2, where n is one of {-
3,-2,-1,1,2,3}.

Intermod — Select the number of intermodulation products reported for the fundamental. Up to 6 IMD products 
can be selected for a fundamental (3 pairs):

 F1 +1/-1 F2 (2 IMD products).

 F1 +2/-2 F2 (4 IMD products).

 F1 +3/-3 F2 (6 IMD products).

Tolerance — The Tolerance field defines the tracking filter window as a percentage from the center of the 
fundamental frequency. This gives the frequency range of a generator for a frequency. 
Detection Filter — Filter Width is used to widen or narrow the measurement filters. 
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Active Measurements — Displays all frequencies that have been added to the measurement configuration. 
Frequencies are listed in MHz. Column headers (from left to right): 

 Fundamental in MHz

 Harmonic (overtone) number (1-5) 

 Intermod number (-3 to 3, 0 means no IMD)

 Frequency in MHz.

 Filter width

Clicking on a fundamental in the list will highlight all frequencies for the fundamental. 
Note: Harmonics or IMD frequencies can be clicked on individually. 

Note: Clicking the “<< Remove” button will remove the highlighted frequencies from the list.

Tracking Settings are displayed to the right of the frequency information.
Min/Max Frequency — Displays the minimum and maximum frequencies the receiver is capable of measuring.
Number of frequency components — Displays the number of selected fundamentals, harmonics, and 
intermods. 

 Maximum of 12 can be selected with the Standard FPGA selected. (See Standard FPGA on page 23.)

 Maximum of 6 can be selected with the Time Domain FPGA selected. (See Time Domain FPGA on page 23.)

Number of intermods — Displays the number of intermods selected. 

 Maximum of 6 can be selected.

Tracking Settings — A Fundamental button is active for each frequency fundamental selected. When clicked the 
open a dialog box for configuring the settings the receiver will use to measure the selected fundamentals, 
harmonics, and intermods.

Figure 32  Tracking Settings

Voltage Noise Level — Minimum threshold required for the voltage reading. If the voltage 
reading is below this level, the voltage reading will show as 0.

Current Noise Level — Minimum threshold required for the current reading. If the current 
reading is below this level, the reading will show as 0.

Measurement — used to select how/when the receiver tracks the fundamental frequency.

 CW - Continuous measurement, no sync pulse required, receiver tracks the fundamental frequency 
during measurement.
 Pulse - Sync pulse is used to determine measurement period, receiver only tracks and measures 
signals during active sync pulse.
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 Multi-Level Pulse - Rising edge of sync pulse is used to start measurement period, up to four pulse 
states, for each fundamental, may be measured during the measurement period, receiver tracks 
frequency during each individual state. States are defined in the Multi-Level Mode area below.

Tracking — Selection for fixed frequency or tracking frequency mode.

 Fixed Frequency Mode - The frequency tracker will not run and the measurement will be fixed to a 
single frequency. The BDS will return measurement values only at this exact frequency. 
 Tracking Frequency Mode - The frequency tracker will sweep through frequencies within the range 
of the selected fundamental's bandwidth to lock onto the test signal's exact frequency.

VI — Allows the user to specify tracking of the measurement signal using the voltage or current. 
If auto tracking is selected, the BDS will perform its signal tracking based on the larger of the 
two.

State 1 - 4 Frequency — Allows the selection of the frequency for each state.

 Fixed Frequency Mode, this specifies the frequency where the measurement will occur for each 
state.
 Tracking Frequency Mode, this specifies which frequency the frequency tracker will begin its search 
from. 

Note: Specifying a frequency close to the actual frequency of the signal will speed up lock time.

Pulse Mode Sync Delay — Allows the entry of time delay, following the sync pulse, before 
the receiver begins measurement.

Multi-Level Mode — Entries are required when Multi-Level Pulse is selected in the fundamental’s Tracking 
Settings. 

Multi-Level Mode options:

 Number of States - This option is used to define the number of states (pulse levels) used during 
each fundamental measurement period. 
 Delay - A time delay, from the rising edge of the sync pulse, must be entered for each state, this 
provides the receiver the information required to begin measurement of each state.
 Duration - The length of time (pulse width) of each state must be defined, for each state. The 
duration value provides the information the receiver needs to measure the full width of each state. 
 Number of Frames - If a state duration is less than approximately 25 µsec, entering the number of 
frames (pulse periods) for a state, allows the receiver to “focus” on tracking a single state for the 
selected number of frames to “lock” onto the frequency. 
 Pulse Period - The length of time (period) of the entire frame of multi-level states. This should 
match the period of the external sync pulse.
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Averaging
The BDS offers two types of data averaging for Standard Tracking Mode: Simple (Fixed) or Moving. Both averaging 
modes will reduce signal-to-noise ratio in a measurement. Averaging is performed in the receiver.

Figure 33  Averaging Dialog

A simple average will take a number of measurements and then compute and report the average value after the 
number of measurements has been sampled. This averaging mode will decrease the data update rate by the number 
of averages requested. 

Example - If the data update rate for 1 measurement dataset is 10ms, then it will take about 40ms to 
average 4 measurements and produce the result. A user can average up to 16 measurements using 
Simple averaging.

The Moving average mode averages data over time using a sliding filter window. The average window size is 
specified as a power of 2 ranging from 2 to 128 measurements. 
The difference between Moving and Simple averaging is that the moving average doesn’t wait for the buffer to fill 
before computing a result, it simply adds a new measurement to the buffer and computes and reports the result. It 
removes the oldest measurement if the buffer is full before adding the new measurement. This provides little impact 
to the data update rate, depending on the measurement set. 
The “V/I Noise Threshold” parameter is used to determine when to clear the filter buffer – when the signal (voltage 
or current) exceeds this threshold the buffer is cleared to provide a fast response to the measurement system.
De-embedding
De-embedding is used to mathematically rotate the measurement plane from the center of the BDS sensor toward 
either the load or the signal source. In doing so, it adjusts measurements made by BDS sensor in order to get a 
reading at a different segment of a line section. 

Figure 34  De-embedding Dialog

The de-embedding algorithm accounts for losses in the RF delivery system. 
The de-embedding options allow users flexibility to enter segment parameters in different formats to match 
segment spec or data sheets. 

 Line section impedance is entered as either inductance and capacitance or Z0 in Ohms. 

 Dielectric is entered as either propagation velocity as a fraction of the speed of speed of light or in Er. 

 Loss can be entered as Ohms, dB, or Nepers.
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Free Run

Figure 35  Free Run Dialog

Use the Free Run scan mode to scan for data until the specified number of datasets have been collected or a timer 
expires, whichever happens first. 
No. Datasets — Specifies the number of datasets to collect.
Avg Power time — Avg Power time is used to set the update interval for the "Avg P(W)" display in the table view.
Display Data Rate — Set the Display Data Rate to the desired time between measurement points.
Continuous Scan — If the “Continuous Scan” check box is checked, then data is scanned continuously and the 
timer is ignored. In Continuous Scan, when the indicated number of datasets has been collected, the oldest data will 
be discarded to make room for new data. 

Example - If the “No. Dataset” field is set to 2000 and “Continuous Scan” is checked; the BDS GUI will 
continuously scan for fresh data. After 2000 datasets are captured; the oldest datasets are discarded to 
make room for new datasets.

Enable Std Tracking Data Reporting via RS232 — Applicable to the model 7001A900-3 receiver. When 
selected, the BDS receiver will respond to RS-232 commands, if unchecked the receiver will respond to RS-232 
commands with an NAK (not acknowledged) message.
Trigger

Figure 36  Trigger Dialog

Use the Trigger scan mode to wait for an event to occur before collecting data. Select the threshold unit(s) and 
levels. A trigger event will occur when any of the selected Voltage, Current, or Delivered Power thresholds are 
detected. Pre- and post-event windows can be specified to include data that is captured before and after the trigger 
event. The Trigger Capture Limits are included to limit the number of datasets acquired, similar to the Free Run 
limits.
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Trigger Capture Limits
Continuous Trigger (Restart After Previous Trigger End) — When selected the BDS will automatically 
reset the trigger state and wait for a new trigger event. 

 If auto-save is used, this will create a new document after saving the old one. The same document window 
is used. 

 If auto-save is not used, a new document (and document window) will be created for each trigger event.

 If not selected the BDS will stop monitoring the trigger state when a trigger event ends.

Auto-reset Maximum Time to Collect — When selected, the BDS will automatically reset the maximum time 
to collect for a trigger. This option keeps the BDS constantly waiting for trigger events. 

 If auto-save is used, this will close the active file and restart a new trigger.

 If not selected the BDS will stop waiting for trigger events when the maximum time to collect is reached.

Maximum Time to Collect — Specifies the time given (in seconds) for trigger events to occur. It also is used to 
limit the run time of the continuous trigger mode in order to prevent the BDS from overwhelming the local log PC 
with too much data. This setting is ignored if the “Auto-reset maximum time to collect” option is selected.
Stop collecting below threshold after n seconds — Allows the BDS to continue collecting data after the 
event is lost.
Transient Detection
Transient Detection is used to identify and report transient events in an RF delivery system. The options available in 
the “Transient Detection” tab are used to specify an arc event and also instruct the BDS how to store the results.

Figure 37  Transient Detection Dialog

Enable Transient Detection — Turns on and off transient detection.
Sample Rate — Period used for peak/magnitude sampling (down-sampled from actual ADC rate). The range of 
the sample rate is determined by the frequency selected in the Lowest Frequency drop down. The sample rate 
(time) should be set to longer than the period of the lowest expected input frequency.

Note: Range: 25 ns to 500 us (based on Lowest Frequency)
Max Length — Length defines the maximum window that the trailing edge of a transient “pulse” must occur in. A 
transient is detected if it has a pulse width less than or equal to the length setting. 

Example - A 400us length will detect transients with pulse widths of 400us, 300us, or less, but not 
401us or 500us. Range is 250 ns to 500 ms (Based on Sample Rate, Sample Rate determines the range 
of the Max Length Setting).

Lowest Frequency — The Lowest Frequency is used to specify the lowest frequency being generated in the 
system where the BDS sensor is installed. This may correspond to the lowest frequency selected on the Frequency 
Selection screen, but is not required. Changes to this setting will update the acceptable range for the Sample Rate.
Trigger Delay — The Trigger Delay parameter determines how the pre/post recording time is set. It is entered in 
the BDS GUI as the percentage of the buffer to report after the falling edge of the transient event.
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Example - A Trigger Delay of 40% would equal 8.19 ms worth of data post-trigger and 12.29 ms worth 
of data pre-trigger.

Min ADC Level — Min ADC Level specifies the minimum count level to accept a transient event. This is used to 
prevent spurious transient events, especially events reported when measuring the noise floor. The value is entered 
as a percentage of full-scale. 

Note: Range is 0-100%. Default is 5%. 
Power Threshold — The Power Threshold parameter is used to define the minimum pulse amplitude that must 
be detected before reporting a transient event. 

Note: Thresholds include: 6 dB, 3 dB, 2 dB, & 1 dB. Default is 3 dB. 
Example - If the 6 dB level is selected, only pulses with amplitudes of 6 dB or greater over the base 
signal are reported as arc events. A 3 dB pulse will not be reported when the 6 dB level is selected.

Report Events When Detected on  — This option allows selection of source for transient detection. A drop-
down list containing the following event reporting options:

 voltage or current channel. Report a transient detected on either the voltage or current channel (default).

 voltage channel only. Report a transient detected on the voltage channel only.

 current channel only. Report a transient detected on the current channel only.

 both voltage and current channels (overlap). Report a transient detected on both the voltage and current 
channels within the same detection window of time (given by “Length” field). 

Ignore Transient Events at Attenuation Change — Transients will be ignored if they occur near a change in 
the attenuation settings of the BDS front end. (This typically occurs during a change in power level or during 
power on/power off conditions). This is only applicable if Auto Gain Control is enabled.
Enable ARC Message Reporting via RS232 — An ARC message will be sent via the RS-232 serial port 
indicating a transient has been detected by the BDS receiver. Applicable to the model 7001A900-3 receiver. 

Note: The ARC message report only applies to receivers configured with an RS-232 port.
Log Data to PC Immediately — This will log the transient results data to the specified folder upon detection of 
a transient event.

Folder — Used to select the location of the transient detection log file.
Show “Transient Detected” Pop-up Window — If checked, will show the pop-up alert box when a transient 
event occurs.
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Spectral Search (Sweep) Mode Options

Sweep
The “Sweep” page provides options for defining the frequency band.

Figure 38  Sweep Dialog

Frequency Step Size — This option allows for the selection of either Linear step size, where each step is the 
same, or Logarithmic step size, where frequencies increase exponentially. The Logarithmic option will provide 
higher resolution (the steps are tighter) at the lower frequencies in the sweep. It is useful for better quality scans of 
the lower frequencies. 
No. Points — The number of points in the sweep can be specified and keep it fixed with the “Fixed” option. 

 If “Fixed” is not checked, then the number of points will be automatically determined based on the start, 
stop, & step. 

 If “Fixed” is checked, then the number of points will remain the same, but the step will change to 
accommodate the sweep.

Start Frequency & Stop Frequency — Defines the frequency band to sweep over.
Note: The available frequency ranges will vary depending the attached sensor, see Specifications on 
page 70.

Frequency Step — The frequency used as the increment when sweeping from the start to the stop frequency. 
Note: This is only used for a “Linear” step size.

Detection Filter — Allows control over the detection filters for a higher or lower resolution picture. This has a 
similar behavior to a resolution bandwidth filter on a spectrum analyzer.
Continuous Sweep — Checking this checkbox will instruct the BDS to keep sweeping across the frequency band. 

Note: This option is required to use sweep data averaging. Not checking this option will instruct the 
BDS to stop sweeping once it completes a single band sweep.
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Default Settings — Clicking this button will restore the default sweep settings.

 Frequency Step Size: Linear

 No. Points: 991 (Fixed)

 Start Frequency: 1 MHz

 Stop Frequency: 100 MHz

 Frequency Step: 47.165 kHz

 Detection Filter: 1 MHz

 Continuous Sweep: Checked

Averaging
Controls the number of sweeps to average. Sweeps are averaged successively as they are made available, so the 
signal-to-noise ratio improves over time. Up to 100 sweeps can be averaged. Sweep data averaging is only available 
when the “Continuous Sweep” option is checked.

Figure 39  Averaging Dialog

Smoothing
Enabling smoothing will filter out noise by averaging a specified number of neighboring points. 

Figure 40  Smoothing Dialog

Smoothing Window Size — Determines how many points to average before and after a center point. 
Smoothing Passes — Specifies the number of passes through the sweep data, the same smoothing filter is 
applied on each pass. 

Note: Smoothing can be used in combination with data averaging. Smoothing may also be used on a 
single sweep (“Continuous Sweep” can be enabled or disabled) or may be changed while sweeping.
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Peak Locator
This page controls the peak locator algorithm that runs on each set of sweep data.

Figure 41  Peak Locator Dialog

No. Peaks — Specify the number of peaks to locate and define the noise threshold in dB that defines a peak. 
Peak Threshold — Sets the peak threshold.

Note: Increasing this may help avoid false positives. 
Peak Lock — Displays all previous peaks on the graph, overlaying the most recent sweep data.
Graph Options
This page provides display options for the frequency-domain sweep view.

Figure 42  Graph Options

Display Units — Allows the user to switch amplitude display formats: 

 Voltage

 Current

 Phase

 Impedance

 Power

 Power (dBm)

Note: The format type can also be selected by right-clicking on the graph and selecting one of these 
format types from the pop-up window. 

Annotate Peaks — This option will display the peak frequencies on the graph.
Transient Detection
The Transient detection tab options for Spectral Search mode are the same as the Standard Tracking Mode options, 
see Transient Detection on page 34.
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Time Domain Mode Options

Time Domain Measurement Tab
The Time Domain Measurement tab is used to define a frequency for the BDS to monitor while in Time Domain 
Mode.

Figure 43  Time Domain Measurement Dialog

Single Frequency — Allows the user to enter a frequency not available on the fundamental list. After entering 
the frequency press the Add>> button must be pressed to select the frequency.
Fundamental — A list of typical measurement frequencies, Once a frequency is selected from the list, press the 
Add>> button to select the frequency. 
Time Scale — Sets the time window for the measurement. Can be selected from 10us to 10ms.
Enable Data Averaging — Allows the user to focus on instantaneous or averaged measurements of the 
waveform.

Average Factor — Configures the percentage of the instantaneous measurement to 
cumulative measurement.

Continuous TD sweep — Allows the user to continuously acquire a new dataset, while discarding the previous 
one.
Customize Graph... — Opens the customization options menu for the display graph.
Graph Measurement Subset — Contains the options available for displaying the receivers measurement 
subsets on the graph. Multiple units may be selected for the selected fundamental.

Fundamental — Selects the fundamental to display on the graph.

Units — Selection of the measurement to be displayed: Voltage, Current, Phase, Impedance, or Power.
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Time Domain Trigger Tab

Figure 44  Time Domain Trigger Tab

Trigger Mode — User can set for the time domain acquisition to begin on a rising or falling edge of the signal.

Internal — User can select between using an internal trigger based on the upper and lower 
thresholds.

External — User can select the external trigger to accept a sync input to indicate the start of a 
measurement.

Trigger Setup — Allow the user to freely view the measurement signal without a trigger level. 
Primarily used when configuring time domain view settings.

Rising/Falling Edge — User can select between rising or falling edge of the voltage or 
current signal to be used as the trigger.

Trigger Delay — Trigger delay as a percentage. Percentage point at which the detected edge of the signal is in 
reference to the measurement display.
Internal Trigger Operation
For rising-edge trigger, the lower threshold condition must be met, followed by the upper threshold condition 
without violating the settling or expire time.
For falling-edge trigger, the upper threshold condition must be met, followed by the lower threshold condition, 
without violating the settling or expire time.
Upper Threshold — Trigger condition will be satisfied when the measurement rises above this threshold.
Lower Threshold — Trigger condition will be satisfied when the measurement falls below this threshold.
Settling Time — Minimum time between two trigger conditions
Expire Time — Maximum time between two trigger conditions
Holdoff Time — Specifies the amount of time, once the trigger condition has been met, during which additional 
triggers will be ignored.
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Chapter 4 Operating Instructions

Overview

An Ethernet Connection is used to control of the BDS receiver via a PC. See "Establishing a Connection to the BDS 
Receiver" on page 42.

Applying Power

The Bird Diagnostic System receiver has a power input connector on the rear panel, the supplied BDS power supply 
should be secured to the BDS using the screw-on barrel connector. The power switch on the rear panel is used to 
apply and remove power to the BDS circuitry.

Status LEDs

The receiver has three status LEDs. Each LED can have four conditions, off (W), on green (G), and on Orange (O). The 
three letters in the Code column are arranged left-to-right as viewed on the instrument. The letters indicate the 
condition of each LED. The meaning of the code is in the description column.

Code Description

WWW No power applied

GWW Loading FPGA image.

GOW Bootloader running

GGW Main applications running, but calibration data has not been 
loaded (cable and probe disconnected).

GGG System is ready with all components connected and all 
calibration data loaded.
Ready for calibrated measurements.
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Establishing a Connection to the BDS Receiver

Direct Connection — A direct connection uses a single Ethernet cable connecting the BDS Receiver to a PC, as 
shown in Figure 45.
When using a direct connection, the IP address on the PC must be set to an address that will allow the PC to connect 
to the BDS Receiver. See "Configuring PC Network Settings to BDS Subnet" on page 42 for instructions on 
manually assigning a PC’s IP address.

Figure 45  Direct Ethernet Connection

Network Connection — A network connection uses existing network infrastructure to provide the physical 
connection between the BDS Receiver to a PC. See Figure 46 for a depiction of this connection.
When using a network connection, the IP address of the PC is typically assigned by the network’s DHCP server. For 
the BDS Receiver’s IP address it is best to setup the DHCP server to assign a “known” address, to make the 
connection process easier. 

Note: DHCP should only be used if you are experienced in determining the IP address assigned by a 
DHCP server, or have configured the DHCP server to assign the BDS Receiver a specific IP address.

Prior to using the BDS Receiver on a network connection, the receiver must be accessed via a direct connection and 
an appropriate IP address manually assigned to the receiver or the receiver must be set to use DHCP. See "Using the 
Web UI" on page 63 for BDS Receiver network configuration instructions.

Figure 46  Network Ethernet Connection

Configuring PC Network Settings to BDS Subnet

Windows 7/10
Note: These instructions apply to a Windows 7/10 PC.

1. Verify an Ethernet cable is connected to the Ethernet Port on the BDS receiver rear panel.
2. Select “Start->Control Panel->Network and Sharing Center” on the PC.
3. Double-click the local area connection and click the “Properties” button.
4. Scroll to “Internet Protocol Version 4 (TCP/IPv4)” and double click.
5. Select “Use the following IP address”.
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6. Enter the following settings:
 IP address: 192.168.0.100

 Subnet mask: 255.255.255.0

 (Gateway is ignored)

Note: These settings will allow the PC to communicate with a BDS Receiver with default IP 
configuration, if the BDS Receiver’s IP configuration has been changed, the PC’s IP configuration must 
be set for the same subnet as the BDS Receiver.

7. Click the “OK” button for the “Internet Protocol Version 4 (TCP/IPv4) Properties” dialog.
8. Click the “OK” button to apply the connection properties.

Restoring PC Network Connection to DHCP

1. Follow steps 1-4 above.
2. Select “Obtain an IP Address Automatically”.
3. Click the “OK” button for the “Internet Protocol (TCP/IP) Properties” dialog.
4. Click the “OK” button to apply the connection properties.

Using the Graphical User Interface

The BDS 2 GUI is used to configure the BDS receiver and obtain measurement data from the system. The BDS GUI 
communicates with the receiver over Ethernet. In order to establish a connection to the BDS receiver, the PC and the 
receiver must be on the same subnet (it has an IP address that is addressable by the PC). See "Establishing a 
Connection to the BDS Receiver" on page 42.

Note: Typically the initial connection to the BDS Receiver is through a Direct Connection. Once a direct 
connection is established the BDS maybe configured for a Network connection. See "Using the Web UI" 
on page 63 for BDS Receiver network configuration instructions.

See "Connectors, Controls and Indicators" on page 9 and "Status LEDs" on page 41 for descriptions of all BDS 
receiver indicators.

Connecting to the BDS Receiver using the GUI

1. Connect the BDS Receiver to an Ethernet connection. See "Establishing a Connection to the BDS Receiver" on 
page 42. 

2. Apply power to the BDS receiver.
3. Confirm that the LED on the left side of the port is illuminated.
4. Launch the BDS GUI on the connected PC.
5. Wait for the BDS Receiver to finish the boot process. 

Note: The power status and Ready Status LEDs (left and center) on the front panel will illuminate 
green when the BDS is ready. 

Note: If a sensor probe is connected, the Sensor Status LED (right) will be illuminated. Any pattern 
other than three green LEDs, with sensor connected, indicates a possible system failure. See "Status 
LEDs" on page 41 for more information.

6. On the BDS GUI, hover the cursor over the Connection menu, then select New….
7. Enter the BDS Receiver’s IP address in the Address: text box. 

Default IP Address: 198.162.0.151.

Note: 198.162.0.151 is the factory default IP address for the Ethernet port on the BDS receiver. If the 
default IP address has been changed the new address must be used with this procedure.
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8. Click the Connect button.
Note: “CONNECTED” should be displayed in the left-most indicator field of the main status bar at the 
bottom of the application window.

Note: The BDS GUI will save your connection settings as defaults. If disconnected from the receiver, a 
connection can be reestablished by either clicking the “Connection” icon, using “Connection>Open”, or 
simply by starting a data acquisition. The BDS configuration may also be saved to an external file or 
recalled from an external file, see "File Menu" on page 22.

Select Mode of Operation

1. To select a mode of operation, hover the cursor over the Mode menu, then move cursor to Switch Mode >, 
then select the desired mode:
 Tracking Mode (TRK),  see "Using Standard Tracking Mode" on page 45. 

 Spectral Search Mode (SP), see "Using Spectral Search (Sweep) Mode" on page 52.

 Time Domain Mode (TD), see "Using Time Domain Mode" on page 55. 

Note: Time Domain Mode can only be used if the option has been purchased AND the Time Domain 
FPGA Image is selected via the mode menu. See "Selecting the Time Domain FPGA Image" on page 
55.

Note: Time Domain Mode is a BDS Receiver option, see "BDS Receiver Options" on page 3.
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Using Standard Tracking Mode

This section provides the minimum steps required to configure the BDS receiver in Standard Tracking Mode.
There are many settings and options available in the Standard Mode of operation.
For more information about Standard Tracking Mode options, refer to "Standard Tracking Mode Configuration" on 
page 28.

Setting the Minimum Configuration

Note: The minimum configuration is one fundamental frequency and no harmonics or IMD.
1. Hover the cursor over the Mode menu, then move cursor to Switch Mode >, then select Tracking Mode (TRK)
2. At the Main menu, select Mode->Options… or click the red reticule icon in the “Options” toolbar. This will open 

Standard Tracking Mode Configuration dialog box.
3. Click on the Frequency Selection tab to bring it to the foreground.

Figure 47  Frequency Selection

4. Select a Fundamental Group from the Fundamental groups Drop down list. 
5. Select desired Fundamental in the Fundamental field list then click the Add>> button to add your selection to 

the Selected Frequencies list at the right. Repeat to add additional fundamental frequencies.
Note: If harmonics are desired for this fundamental frequency, click on each “H” button that 
represents the harmonics you desire (e.g. H1, H2, H3, H4).

Note: To remove a frequency or harmonic from the Selected Frequency list, select it then click the 
<<Remove button.

6. Add more fundamental frequencies and harmonics as desired. When you are finished adding frequencies and 
harmonics, click the Apply button.
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7. Select Tracking Settings for each fundamental:
 CW - continuous measurement, no sync pulse required, receiver tracks the fundamental frequency 
during measurement.
 Pulse - Sync Pulse is used to determine measurement period, receiver only tracks and measures 
signal during active sync pulse.
 Multi-Level Pulse - Rising edge of sync pulse is used to start measurement period, up to four pulse 
states, for each fundamental, may be measured during the measurement period, receiver tracks 
frequency during each individual state.

a. If Multi-Level Pulse was selected, configure the Multi-Level Mode options:

 Select the number of states within each Pulse Period.

 Enter a delay from the sync pulse for each state.

 Enter a duration for each state.

 If a state duration is less than 25 µsec, enter the number of frames (pulse periods), that must occur 
before the next state signal is acquired. 

8. Click the Free Run tab to bring it to the foreground.
9. In the “No. Datasets” field, enter the number of datasets to capture.
10. Set the Display Data Rate to the desired measurement interval.
11. Do one of the following:

 Select the Continuous Scan check box for the data acquisition to continue uninterrupted. 

Note: In Continuous Scan, when the specified number of data sets has been captured, the system will 
discard the oldest data set and store the newest data set (first-in-first-out method) so that you will 
always have the specified number of data sets.

 Do not select Continuous Scan for the data acquisition to stop only after the specified number of 
data sets or after the specified Run Time expires.

12. Click the Apply button to apply the values and keep the dialog box open or click the OK button to apply the 
values and close the dialog box.

Acquiring Fresh Data

Select Mode -> Start Free Run from the main menu to start the data acquisition.
Note: Clicking the green Run button on the “Scan” toolbar will also start an acquisition.

Stopping the Data Acquisition

The data acquisition can be stopped by doing one of the following at any time:

 Select the Mode -> Stop Acquisition from the main menu. 

 Press the red Stop button from the “Scan” tool bar.
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Saving the Document

Select File -> Save As… from the main menu. See Figure 48 on page 47.
Note: If the data will be analyzed using another application such as MS Excel, see "Viewing Captured 
Data Using MS Excel" on page 60.

Figure 48  Saving the Document in Standard Tracking Mode
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Viewing the Data

Data can be viewed while it’s being collected or after a data acquisition completes. The data is displayed in the 
following formats:

 Table

 Time plot

 Smith chart

These views can be accessed and switched at any time by:

 Selecting a different view using the buttons on the View tool bar (Figure 49 on page 48).

 Right-clicking anywhere on a view and choosing from the pop-up menu.

 Selecting View and your choice from the main menu.

Note: View options are available by selecting “View->Options…” from the main menu or by right 
clicking anywhere on a view and selecting “Options…” from the pop-up menu.

Table View

Figure 49  Data in Tabular Format and View Selection Buttons

The table view displays the most recently collected dataset in tabular form. The fields are described in detail below:

 Dataset - The dataset number - a count of how many datasets have been received for the document.

 Timestamp - The time the dataset was captured from the BDS receiver.

 Elapsed (ms) - The time (in milliseconds) between measurement datasets, giving an indication of data 
update rate.

 AGC - Automatic gain control indicator. 

Note: Displays “Yes” if automatic gain control is used or “No” if manual gain control is used.

 Cal - Measurement calibration indicator. 

Note: Displays “Yes” if the displayed measurement dataset has been calibrated or “No” if it has not 
been calibrated. 

Note: Check the probe connection to the receiver if the BDS GUI is indicating that the measurements 
are not being calibrated.

 Transient - Transient detected during the displayed measurement cycle. 

Note: This will display “No” if no transient event has been detected or “Yes” with a red background if a 
transient has been detected during the measurement cycle.
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 Attn V (dB) -The attenuation applied (in dB) to the voltage channel during this frequency measurement.

 Attn I (dB) -The attenuation applied (in dB) to the current channel during this frequency measurement.

 Step - Indicates the step of the recipe. 

The data table displays the following information for each harmonic component returned in the dataset:

 F set (Hz) - The set point of the frequency measurement in Hz. 

 F actual (Hz) - The actual measured frequency in Hz. 

 Meas State - In multi-level mode, this specifies which state (1-4) the measurement occurred in. 

 Vrms (Volts) - RMS voltage reading.

 Irms (Amp) - RMS current reading.

 Phase (Deg) - The phase in degrees between V and I. This is equivalent to the phase angle of the impedance 
(in polar coordinates).

 Z (Ohms) - Impedance magnitude in Ohms (in polar coordinates). 

Note:
 R (Ohms) - Resistance in Ohms - the real part of impedance (in rectangular coordinates).

 jX (Ohms) - Reactance in Ohms - the imaginary part of impedance (in rectangular coordinates).

 PDel (Watts) - Power in Watts. 

Note:
 PFwd (W) - Calculated forward power of the signal (Z must be between 25 and 100 Ohms and phase angle 

must be within +/-20 degrees or the measurement is void and reads n/a).
 PRfl (W) - Calculated reflected power of the signal (Z must be between 25 and 100 Ohms and phase angle 

must be within +/-20 degrees or the measurement is void and reads n/a).
 Rel P (dBc) - Power relative to the fundamental in dBc. Applies to harmonics and intermods.

 Rel Ph (Deg)– Phase relative to the fundamental in degrees. Applies to harmonics and intermods.

 Avg P (W) - Averaged delivered power (calculated based on the "Avg Power time" setting in the "Free Run" 
tab under the standard tracking mode configuration settings).

Z V I=

P Vrms Irms  Phase cos=
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Time Plot View

Figure 50  Data Viewed in Time Plot Format

Note: The Time Plot view displays each dataset over time. The dataset number is displayed on the X-
axis.

Time Plot Display Options
The Time Plot display options are available by selecting “View->Options…” from the menu bar or by right clicking 
anywhere on the display and selecting “Options…” from the pop-up menu.
The Fundamentals selected in the Mode Options dialog ("Frequency Selection  Tab" on page 28), will be available 
in the fundamental drop down menu on the Time Plot Tab of the View Options dialog.
Fundamental — Selections on this menu will mirror the frequencies selected in the Mode Options 
(See "Frequency Selection Tab" on page 28).
Harmonic — Selections on this menu will mirror the frequencies selected in the Mode Options 
(See "Frequency Selection Tab" on page 28).
State — Selections will mirror states selected in Mode Options, If Multi level pulse was selected in the Mode 
Options (See "Frequency Selection  Tab" on page 28).
Units — Allows the selection of unit of measurement/signal component to display on the Time Plot for the selected 
fundamental.
Add>>/<<Remove — The Add button allows the user to enter multiple fundamentals/units of measure. The 
remove button allows the user to remove any fundamental selected in the frequency list. 
Strip Chart — When check box is checked, the No. Points option is activated.

No. Points — The value for the number of points set the scale for the 
Customize Graph — Opens a dialog box that allows the user to change the appearance of the graph.

Figure 51  Display Options for the Time Plot 
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Smith Chart View

Figure 52  Data Viewed in a Smith Chart

Note: The Smith Chart view displays data normalized to 50 Ohms (a value of 1 on the horizontal axis 
represents 50 Ohms).

Smith Chart Display Options
The Smith Chart display options are available by selecting “View->Options…” from the menu bar or by right clicking 
anywhere on the display and selecting “Options…” from the pop-up menu.
The Fundamentals selected in the Mode Options dialog ("Frequency Selection  Tab" on page 28), will be available 
in the fundamental drop down menu on the Smith Chart Tab of the View Options dialog.
Fundamental — Selections on this menu will mirror the frequencies selected in the Mode Options 
(See "Frequency Selection Tab" on page 28).
Harmonic — Selections on this menu will mirror the frequencies selected in the Mode Options 
(See "Frequency Selection Tab" on page 28).
State — Selections will mirror states selected in Mode Options, If Multi level pulse was selected in the Mode 
Options (See "Frequency Selection  Tab" on page 28).
Add>>/<<Remove — The Add button allows the user to enter multiple fundamentals/units of measure. The 
Remove button allows the user to remove any fundamental selected in the frequency list. 
Display Mode — When check box is checked, the No. Points option is activated.

Historical — Displays the current and historical value for the selected fundamental(s). 

Single Point — Displays the current value of the selected fundamental(s).
Data Normalized to — Offers the ability to select the value of normalization for the data, default value is 50 
Ohms.
Customize Graph — Opens a dialog box that allows the user to change the appearance of the graph.

Figure 53  Display Options for the Time Plot 
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Using Spectral Search (Sweep) Mode

To collect data in the Spectral Search Mode you can simply use the default sweep configuration and then start a 
Sweep.
There are many settings and options available in the Spectral Search Mode of operation.
For more information about Spectral Search Mode options, refer to "Spectral Search (Sweep) Mode Options" on 
page 36.

Setting the Minimum Configuration

1. At the main menu, select Switch Mode >, then select Spectral Search Mode (SP).
2. Select Mode -> Options… from the main menu or click the broom icon in the “Options” toolbar to open the 

Sweep Mode Configuration dialog box.
3. Click on the Sweep tab.
4. Click the Default Settings button.
5. Click the OK button to apply the settings and close the dialog.

Acquiring Fresh Data

Select Mode -> Start Spectral Sweep (SP) from the main menu to start the data acquisition.
Note: Clicking the green Run button on the “Scan” toolbar will also start an acquisition.

Stopping Data Acquisition

The data acquisition can be stopped at any time by performing one of the following:

 Select Mode -> Stop Acquisition from the main menu 

 Use the red Stop button from the “Scan” tool bar.

Saving the Document

1. Select File -> Save As… from the main menu. 
Note: If the data will be analyzed using another application such as MS Excel. Auto save options can 
be set up by selecting “Mode->Options…” from the main menu. 

Viewing the Data

Data can be viewed while it’s being collected or after a data acquisition completes. The data is displayed in the 
following formats:

 Peaks - Table of Peaks

 Sweep - Frequency-Domain View

These views can be accessed and switched at any time by:

 Selecting a different view using the buttons on the View tool bar.

 Right-clicking anywhere on a view and choosing from the pop-up menu.

 Selecting View and your choice from the main menu.

Note: View options are available by selecting “View->Options…” from the main menu or by right 
clicking anywhere on a view and selecting “Options…” from the pop-up menu.
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Viewing Data in the Frequency Domain

Figure 54  Viewing Data in the Frequency Domain

Note: Each data point is displayed as amplitude over frequency, with frequency on the x-axis.

Amplitude display formats can switched by right-clicking on the graph and selecting one of the format types from 
the pop-up window: 

 Voltage

 Current

 Phase (Deg)

 Impedance

 Watts

 dBm. 

Note: Format type can also be selected from the Spectral Search Options.
Marker Usage — Up to 2 markers can be used to view data point details or deltas between 2 data points on the 
graph. The active marker, the one with user input focus, is in red and the inactive marker is in black.
Marker Keys — 

 Up Arrow – Place the active marker at the maximum value (the highest peak).

 Left Arrow – Move the active marker to the previous point. Tap to move one point at a time or hold to 
incrementally skip points.

 Right Arrow – Move the active marker to the next point. Tap to move one point at a time or hold to 
incrementally skip points.

 E – On/Off – Enable or disable the active marker.

 P – Cycle through peaks, placing the active marker at the next peak.

 1 – Activate (and enable) marker number 1.

 2 – Activate (and enable) marker number 2.

Viewing Data in a Table of Peaks 
The peak table view displays the peak values most recently located in the sweep in a tabular form. The fields are:

 Sweep - The sweep number - a count of how many sweeps have been made since the acquisition was 
started.

 Timestamp - The time the sweep dataset was captured from the BDS receiver.

 Elapsed (ms) - The time (in milliseconds) between sweeps, giving an indication of data update rate.

 AGC - Automatic gain control indicator. 
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Note: Displays “Yes” if automatic gain control is used or “No” if manual gain control is used.

 Cal – Measurement calibration indicator. 

Note: Displays “Yes” if the sweep data has been calibrated or “No” if it has not been calibrated. 

Note: Check the probe connection to the receiver if the BDS GUI is indicating that the measurements 
are not being calibrated.

 Arc – Arc (transient) detected during the displayed measurement cycle. 

Note: This will display “No” if no transient event has been detected or “Yes” with a red background if a 
transient has been detected during the measurement cycle.

 Peak – The peak number. Peaks are listed in ascending order (highest to lowest).

 F (Hz) – The frequency of the peak in Hz.

Selected amplitude. One of the following:

 Vrms (Volts) – RMS voltage.

 Irms (Amps) – RMS current.

 Z (Ohms) – Impedance in Ohms.

 P (Watts) – Power in Watts.

 P (dBm) – Power in dBm.
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Using Time Domain Mode

Time Domain mode is an option available for the BDS receiver. The Time Domain mode allows unprecedented 
visibility into the shape of pulsed RF waveforms in the non 50-Ohm environment. Very similar to an oscilloscope, the 
BDS will display a one-shot, triggered view of the pulse envelope. Very different from an oscilloscope, the BDS will 
display the waveform in voltage, current, phase, power, or impedance to the fully-specified accuracy of the system.

Selecting the Time Domain FPGA Image

Note: A Time Domain option license must have been installed to allow selection of the Time Domain 
FPGA. See "Installing a BDS Receiver Option License" on page 15.

The BDS Receiver will not allow selection of the Time Domain Mode until the Time Domain FPGA Image is selected 
via the mode menu.
1. On the mode menu, Select Switch FPGA -> Time Domain FPGA.
2. Click Yes on the confirmation message, to switch to the Time Domain FPGA and reboot the BDS Receiver. See 

Figure 55.

Figure 55  Switch FPGA Confirmation Message

3. Continue to Setting the Minimum Configuration for the Time Domain Mode.



Bird Diagnostic System

56

Setting the Minimum Configuration

1. On the mode menu, select Switch Mode -> Time Domain Mode (TD).
2. Then select Mode -> Options…

or click the pulse icon on the “Options” toolbar to open the Time Domain Mode Configuration dialog box.
3. Click on the Time Domain Measurement tab. See Figure 56.

a. In the Measurement area, select a Fundamental Frequency from the list, or enter a frequency into the 
Single Frequency text box, click the Add>> button.

b. Set the time scale to the desired length of time to be displayed. Range is 10 usec to 10 msec.
c. In the Graph measurement Subset area, select Units to be displayed from the drop down menu, click 

the Add>> button following each selection.
d. Select additional options, if desired:

 Enable Data Averaging

 Continuous TD Sweep

e. Click Apply

Figure 56  Time Domain Measurement Options Tab

4. Click on the Time Domain Trigger tab.
a. Set the trigger delay to correspond with the desired location of the rising edge of the pulse. 

50% will set the rising edge in the middle of the time scale.
b. Set the trigger mode to one of three options:

 Trigger Setup - The time domain sweep will run freely without any trigger conditions.

This allows for visualizing the pulses and the trigger thresholds so they can be set up 
properly.

Note: if pulses occur infrequently, they may not always occur during the sweep. 
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 External Trigger - The time domain sweep will be synchronized with the externally applied SYNC 
signal.
 Internal Auto - The time domain sweep will trigger automatically when the user-defined trigger 
thresholds are satisfied.

c. Set the trigger thresholds (used only for Internal Auto mode)
For rising-edge trigger, the lower threshold condition must be met, followed by the upper threshold 
condition without violating the settling or expire time.
For falling-edge trigger, the upper threshold condition must be met, followed by the lower threshold 
condition, without violating the settling or expire time.

 Upper Threshold - Trigger condition will be satisfied when the measurement rises above this 
threshold.
 Lower Threshold - Trigger condition will be satisfied when the measurement falls below this 
threshold.
 Settling Time - Minimum time between two trigger conditions

 Expire Time - Maximum time between two trigger conditions

 Holdoff Time - Specifies the amount of time, once the trigger condition has been met, during which 
additional triggers will be ignored.

Figure 57  Time Domain Trigger Tab
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Acquiring Fresh Data

Select Mode -> Start Time Domain (TD) from the main menu to start the data acquisition.
Note: Clicking the green Run button on the “Scan” toolbar will also start an acquisition.

Stopping Data Acquisition

The data acquisition can be stopped at any time by performing one of the following:

 Select Mode -> Stop Acquisition from the main menu. 

 Click the red Stop button from the “Scan” tool bar.

Saving the Document

1. Select “File->Save As…” from the main menu. 
Note: If the data will be analyzed using another application such as MS Excel. Auto save options can 
be set up by selecting “Mode->Options…” from the main menu. 

Viewing the Data

Data can be viewed while it’s being collected or after a data acquisition completes. The data is displayed in the 
following format:

 Time-Domain View

These views can be accessed and switched at any time by:

 Selecting a different view using the buttons on the View tool bar.

 Right-clicking anywhere on a view and choosing from the pop-up menu.

 Selecting View and your choice from the main menu.

Note: View options are available by selecting “View->Graph Options…” from the main menu or by 
right clicking anywhere on a view and selecting “Graph Options…” from the pop-up menu.
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Viewing Data in the Time Domain

Figure 58  Viewing Data in the Time Domain

Note: Each data point is displayed as amplitude over time, with time on the x-axis.

Right click on the graph to display the graph options and markers.
Markers — Right click on the graph and select markers. Up to 2 markers can be used to view data point details or 
deltas between 2 data points on the graph. The active marker, the one with user input focus, is in red and the 
inactive marker is in black.
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Viewing Captured Data Using MS Excel

See "Saving the Document" on page 47 in Using Standard Tracking Mode or see "Saving the Document" on page 
52 in Using Spectral Search (Sweep) Mode for details on saving data files.

CSV File Format Description

Header fields are listed in the first row in the file. Measurement data is listed in all subsequent rows. A comma 
separates each field or data point.
Standard Tracking Mode
Measurement data saved into the Standard Tracking Mode CSV file is determined by the options selected in the File 
Options Dialog Box, see "Customizing Output Parameters" on page 25. 
Table 3 shows the format of a CSV file with all output parameters selected.

Table 3  Standard Tracking Mode CSV Format Description

Column Header Description
1 Step Internal Bird use.
2 Timestamp Date and Time of measurement.
3 Time(ms) The time in milliseconds from the beginning of the file.
4 Arc Arc detection status. 0 if no transient was detected during the measurement 

cycle or 1 if a transient was detected.
5 AttnV Attenuation applied to the voltage channel while measuring the point.
6 AttnI Attenuation applied to the current channel while measuring the point.
7 NumAvg
8 F1_Freq_h_1 Frequency in MHz for the 1st fundamental (overtone H1).
9 F1_V_h_1 RMS Voltage for the 1st fundamental (overtone H1). 
10 F1_I_h_1 RMS Current for the 1st fundamental (overtone H1).
11 F1_Ph_h_1 Phase
12 F1_PhDeg_h_1 Phase in radians for the 1st fundamental (overtone H1).
13 F1_Impedance_h_1 Impedance in Ohms
14 F1_Resistance_h_1 Resistance in Ohms
15 F1_Reactance_h_1 Reactance in Ohms
16 F1_DelPower_h_1 Power in Watts
17 F1_FwdPower_h_1 Forward Power in Watts
18 F1_RflPower_h_1 Reflected Power in Watts
19 F1_dBc_h_1 Relative Power
20 F1_PhRel_h_1 Relative Phase
21 F1_PhRelDeg_h_1 Relative Phase

~ ~ ~
xx Fn to end-of-row Row definitions are repeated for all measurement frequencies, harmonics, and 

intermods.
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Table 4  Spectral Search Mode CSV Format Description

Table 5  Time Domain Mode CSV Format Description

Column Header Description
1 AttnV Attenuation applied to the voltage channel while measuring the point.
2 AttnI Attenuation applied to the current channel while measuring the point.
3 Frequency (Hz) Frequency reported for the step point in Hz.
4 RMS Voltage (Volts) RMS Voltage reported for the step point.
5 RMS Current (Amps) RMS Current reported for the step point.
6 Phase (Deg) Phase in radians for the step point.
7 Impedance (Ohms) Impedance in Ohms
8 Power (Watts) Power in Watts
9 Power (dBm) Power in dBm

Column Header Description
1 Time (uSecs)
2 RMS Voltage RMS Voltage reported for the step point.
3 RMS Current RMS Current reported for the step point.
4 Phase (R) Phase in radians for the step point.
5 AttnV Attenuation applied to the voltage channel while measuring the point.
6 AttnI Attenuation applied to the current channel while measuring the point.
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Table 6  Transient Detect CSV Format Description

Column Header Description
1 Voltage ADC Voltage ADC counts. Range: 0-127 for 8-bit, 0-2047 for 12-bit mode.
2 Current ADC Current ADC counts. Range: 0-127 for 8-bit, 0-2047 for 12-bit mode.
3 Voltage Attn Attenuation applied to the voltage channel in dB.
4 Current Attn Attenuation applied to the current channel in dB.
5 Timestamp Timestamp of the when the arc event occurred.
6 ADC Mode The ADC mode (8-bit or 12-bit).
7 Desc Description of the event, if any.
8 Step Internal Bird use.
9 Elapsed (ms)
10 ID  Indicates the event number of the current transient. (Note: Per run, BDS can 

record up to 128 transient events through GUI logging).
11 Num Points The number of points contained in the file. 0-4096 for 8-bit. 0-2048 for 12-bit.
12 Sample Rate The peak sampling rate in nanoseconds.
13 Arc Length The maximum pulse length in nanoseconds.
14 Trigger Delay 

(Counts)
Trigger delay as a percentage.

15 Power Threshold 
(dB)

Minimum pulse amplitude that must be detected before reporting a transient 
event.

16 Min ADC (%) Minimum signal level measured by the ADC
17 Report V Indicates if the transient was detected on the voltage channel
18 Report I Indicates if the transient was detected on the current channel
19 Sign V Indicates if the transient on the voltage channel was a rising or falling edge 

event (+1 for rising edge, -1 for falling edge)
20 Start V Point in the data buffer where the transient on the voltage channel begins
21 Stop V Point in the data buffer where the transient on the voltage channel ends
22 Sign I Indicates if the transient on the current channel was a rising or falling edge 

event (+1 for rising edge, -1 for falling edge)
23 Start I Point in the data buffer where the transient on the current channel ends
24 Stop I Point in the data buffer where the transient on the current channel ends
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Chapter 5 Maintenance

This chapter describes routine maintenance, along with troubleshooting instructions for the Bird Diagnostic System 
(BDS). For service beyond this level, return the unit to a qualified service center.
The BDS requires only simple, routine maintenance.

 Wipe off dust and dirt regularly.

 Check the connectors and cables for damage.

 Clean the connector contacts with alcohol or dry cleaning solvent.

Cleaning

To clean the Bird Diagnostic System receiver, use only a soft cloth dampened with mild detergent and rinse with 
water. Clean the sensor with alcohol or a dry cleaning solvent that leaves no residue.

Using the Web UI

The Web UI is accessed using a web browser, by entering the BDS’s IP address in the web browser. 

Web UI Login

1. Connect Ethernet cable to the Ethernet Ports on the BDS Receiver and the PC.
2. Power up the receiver (wait for left and center status indicators to illuminate green).
3. Launch the Web Browser on the PC.
4. Type the IP Address for the BDS receiver into the web browser’s address bar.

BDS Default IP Address: 192.168.0.151
5. Click Login on the left side of the BDS Receiver’s web page.
6. Enter the Login credentials for the BDS Receiver. 

Default Login: admin
Default Password: admin

Figure 59  Web UI Login Screen
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Changing BDS Receiver’s IP Address

Figure 60  Network Settings Menu

1. Log into the WebUI, see "Web UI Login" on page 63.
2. Click Setup menu.
3. Click Network Tab.
4. Select IP Address Mode: 

 Static IP - If selected, the new IP Address, subnet mask, and Gateway must be entered manually

 DHCP - If selected, a DHCP will assign an IP Address when the BDS Receiver is powered on.

5. If Static IP is selected, type new IP Address, Subnet Mask, and Gateway into the boxes provided.
6. Click Save button to save changes to network settings. 
7. Cycle the BDS Receiver’s power for the new network settings to take effect.
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Update BDS Receiver’s Time Setting

Figure 61  Time Settings Menu

1. Log into the WebUI, see "Web UI Login" on page 63.
2. Click Setup menu.
3. Click Time Tab.
4. Select Update Time check box.
5. Click << button or >> button to select the current month and year.
6. Click the current day in the calendar.
7. Type the current time into the Hr., Min., Sec. text boxes.
8. Click the Save button.

Configure BDS Receiver to use NTP Time Server

1. Log into the WebUI, see "Web UI Login" on page 63.
2. Click Setup menu.
3. Click Time Tab.
4. Select Enable Network Time Protocol check box.
5. Type the NTP Server location into the NTP Server text box.
6. Type the desired update interval into the Update Interval: hr and min text boxes.
7. Click the Save button.
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Installing an Option License

Options are available to extend the functionality of the BDS Receiver. An option license must be installed on the BDS 
receiver to activate a purchased option. 
The following steps are required to install a license. 

Equipment

 BDS Receiver

 PC 

 Ethernet Cable

License Installation

Obtain License
An option license is an electronic file which, when installed on the BDS Receiver, activates the optional functionality.
1. Purchase an option license.
2. Save the license file on the PC you will use to install the license on the BDS receiver.
Install License
1. Log into the WebUI, see "Web UI Login" on page 63.
2. Click License menu.

Figure 62  License File selection

3. Click Choose File.
4. Navigate to the Option License (licenseXXXXXXXXX.cfg.bdsu) located on the PC. See Figure 63.

Figure 63  File Navigation

5. Click Open.
6. Click Upload File. See Figure 64.
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Figure 64  Upload Option File to BDS Receiver

7. Once the file is successfully uploaded, click Activate License. See Figure 65.

Figure 65  License Activation

8. Click Reboot to complete License activation, see Figure 66.

Figure 66  Reboot BDS Receiver

9. Following the reboot of the BDS Receiver, the additional function with be available via the BDS GUI, see 
"Graphical User Interface" on page 22.
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Installing BDS Receiver Firmware Update

Obtain Firmware
Firmware files for the BDS Receiver may be downloaded from the product page on Birdrf.com.
1. Download the Firmware File (.zip file).
2. Save the license file on the PC you will use to install the license on the BDS receiver.
Install Firmware

Note: The BDS receiver has the default IP address of 192.168.0.151. See "Configuring PC Network 
Settings to BDS Subnet" on page 42.

1. Log into the WebUI, see "Web UI Login" on page 63.
2. Click Updates menu.
3. Click Choose File and navigate to the firmware file (XXXXXXXXX.mender.bdsu) located on the PC.
4. Click Upload File button to upload the file.

Figure 67  BDS Firmware Update - File Selection

5. Wait approximately 1 minute as the file is uploaded to the receiver. 
After file upload is completed, a “File uploaded successfully” message will be displayed. 

6. Click the Apply Update button, see Figure 68.

Figure 68  Apply Firmware Update

Note: The screen will not be changing during this time so please be patient and wait for the next 
screen to load. 

7. Wait approximately 3-6 minutes as the BDS applies the update. 
Upon completion of the applied update you will see confirmation on the webpage showing “Update was 
applied successful. Please reboot the BDS for the update to take effect”. 

8. Click the Reboot button. See Figure 69.

www.birdrf.com
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Figure 69  Firmware Installation Reboot

9. Refer to the LEDS on the front panel of the BDS. 
Once the unit has finished rebooting the three status LEDs are glowing green. 

Note: wait 20 seconds after the three status LED’s are green before continuing.
10. Click Confirm Update button on the webpage, see Figure 70.

Figure 70  Confirm Update

11. Wait for the “Update confirmed successfully. Please reboot the BDS fr the update to take effect” message 
before continuing. See Figure 71.

12. Click Reboot button on the webpage to reboot the BDS receiver a second time. 

Figure 71  Final Reboot

13. Wait for the three LEDs on the front of the BDS return to green.
14. The receiver may now be used for RF Measurement.
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Specifications

General Specifications

Parameter Specification

RF power, max Max RF power is sensor dependent. See Figure 72 
on page 71 for max power of a standard sensor.

Frequency range 307 kHz - 252 MHz (sensor dependent)
Frequency resolution 100 Hz
Frequency accuracy ± 1 kHz
Number of fundamental tracking channels 
(F0) 3

Number of Harmonic and Intermodulation 
Product tracking channels

4 harmonics per fundamental, 6 intermodulation 
products per pair of fundamentals, up to 252 MHz. 
Limited by maximum number of measurement 
channels.

Maximum RF Level for Voltage and Current 
Inputs +27dBm, auto gain control on

Receiver Phase Angle Measurement Range -180° to +180°
Input Attenuation Range 30 dB, 6 dB steps
Instantaneous Dynamic Range 70 dB
Processing gain 30 dB minimum
Signal-to-Noise Ratio (SNR) 65 dB

Operating Modes
Tracking Mode (CW, Pulse, Multi-Level Pulse) 
Spectral Search Mode
Time Domain Mode (with license)

Mode Configuration Via BDS UI or customer specific protocol
Interfaces

7001A900-2
7001A900-3

Ethernet
Ethernet, RS-232

Operating Power 15 VDC, 2.5 A, Limited Power Source
Temperature Derating 0.05% / °C  and  0.1° / °C
Warm-up Time 15 Minutes
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Figure 72  BDS System Max Power
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Tracking Mode Specification.

Time Domain Mode Specification

Transient Event Detection Specification

Parameter Specification
Signal Type CW, pulse, and multi-level pulse
Frequency Tracking Up to 2 GHz/s
Pulse Characteristics PRR ≤ 10 kHz, Duty cycle 5% – 95% (5 us min. pulse width)
Pulse Gate External TTL (0 to 24V tolerant)
Measurements CW magnitude and phase, Pulse-on magnitude and phase
Tracking Modes Auto frequency tracking, fixed frequency
Dataset Content Voltage, current, phase, frequency, impedance, power
Dataset Resolution IEEE 754 Single Precision Floating Point

Dataset Update Ratea

a. A dataset includes measurement data for all the configured fundamentals, harmonics, and
intermods, with dataset averaging set to 1. Network congestion is not taken into account in
this specification.

500 Hz maximum

Parameter Specification
Measurements Pulse envelope over time of a single fundamental
Time scale range 10us to 10ms
Sweep type Single or continuous
Sweep trigger Free run, Internal, External TTL (0 to 24V tolerant)
Dataset Content Voltage, current, phase, impedance, power
Dataset Resolution IEEE 754 Single Precision Floating Point

Dataset Update Rate Dependent on time scale

Parameter Specification
Sample Rate 40 MHz (25 ns) to 2 kHz (500 us)
Event Length 250 ns to 2 ms (based on sample rate)
Noise Gate 2-12% of full scale (to avoid false detections from noise)
Amplitude Threshold 1dB, 2dB, 3dB, 6dB
Event Direction Positive, Negative
Event Reporting Logic V only, I only, V OR I, V AND I
Event Data (per event) Event Number, Event Length, Event Intensity, Raw ADC Data
Raw Data Buffer Length 2048 samples
Event Data Storage Up to 128 events, in local memory
Time Between Events 0s.  Gapless detection and capture, up to 128 events.
Data Retrieval Via BDS UI or customer specific protocol
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Ethernet Specification

Voltage, Current and Phase Measurement Characteristics

Parameter Specification

Interface 10/100/1000BASE-T (auto-sensing)
Version 2.0/IEEE 802.3

Protocol TCP/IP

Parameter Voltage Current Phase Angle
Measurement Range 1-3000 Vrms a

a. Maximum current and voltage are limited by the size of the sensor line section and connectors. See sensors
specifications.

0.1 – 100 Armsa –180° to +180°
Resolution IEEE 754 Single Precision Floating Point
Uncertainty
307 kHz - 1 MHz 
Unlocked Systemb

(Note 2)

b. At customer specified frequencies.

for Fo, ± 1.0 V or 2% of 
reading, whichever is greater, 
for Fn , ± 2.0 V or 4% of 
reading, whichever is greater 
(95% confidence interval)

for Fo, ± 0.1 A or 2% of reading, 
whichever is greater, for Fn, ± 
0.2 A or 4% of reading, 
whichever is greater (95% 
confidence interval)

Absolute Angle: 
for Fo, 10 V, 1 A:, ±1°
for Fo, <10 V, 1 A:, ±4°
for Fn,  10 V, 1 A:, ±2°
for Fn, < 10 V, 1 A:, ±6°
(95% confidence interval)

Uncertainty
1 - 252 MHz
Unlocked System
(Note 2)

for Fo, ± 0.2 V or 2% of 
reading, whichever is greater, 
for Fn , ± 0.4 V or 4% of 
reading, whichever is greater 
(95% confidence interval)

for Fo, ± 0.02 A or 2% of 
reading, whichever is greater, 
for Fn, ± 0.04 A or 4% of 
reading, whichever is greater 
(95% confidence interval)

Absolute Angle: 
for Fo, 10 V, 1 A:, ±1°
for Fo, <10 V, 1 A:, ±4°
for Fn,  10 V, 1 A:, ±2°
for Fn, < 10 V, 1 A:, ±6°
(95% confidence interval)

Uncertainty
307 kHz - 1 MHz
Locked System
(Note 2)

for Fo, ± 0.5 V or 1% of 
reading, whichever is greater, 
for Fn , ± 1.0 V or 2% of 
reading, whichever is greater 
(95% confidence interval)

for Fo, ± 0.05 A or 1% of 
reading, whichever is greater, 
for Fn, ± 0.1 A or 2% of reading, 
whichever is greater (95% 
confidence interval)

Absolute Angle:
for Fo,  10 V, 1 A:, ±1°
for Fo, <10 V, 1 A:, ±4°
for Fn,  10 V, 1 A:, ±2°
for Fn, < 10 V, 1 A:, ±6°
(95% confidence interval)

Uncertainty
1 - 252 MHz
Locked System
(Note 2)

for Fo, ± 0.1 V or 1% of 
reading, whichever is greater, 
for Fn , ± 0.2 V or 2% of 
reading, whichever is greater 
(95% confidence interval)

for Fo, ± 0.01 A or 1% of 
reading, whichever is greater, 
for Fn, ± 0.02 A or 2% of 
reading, whichever is greater 
(95% confidence interval)

Absolute Angle:
for Fo,  10 V, 1 A:, ±1°
for Fo, <10 V, 1 A:, ±4°
for Fn,  10 V, 1 A:, ±2°
for Fn, < 10 V, 1 A:, ±6°
(95% confidence interval)
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Physical and Environmental

Indicators and Connectors

Parameter Specification
Receiver Dimensions 5.5” width x 7.4” depth x 1.6” height 
Receiver Weight 1.5 lb (0.68 kg)
Temperature

Receiver Operating
Receiver Storage

+20 to +40 °C (68 to 104 °F)
–20 to +80 °C (–4 to +176 °F)

Humidity, maximum 85% Non-condensing
Air Pressure, minimum 745 mbar (equivalent to 2,500 m / 8,200 ft. max altitude)

Safety Standards

UL 61010-1, 3rd Ed., Rev. July 19, 2019
CAN/CSA C22.2 No. 61010-1, 3rd Ed., A1: 2018
UL 61010-2-030, 2nd Ed., Dec. 21, 2018
CAN/CSA C22.2 No. 61010-2-030, 2nd Ed., 2018
SEMI S2-0706 for Environmental, Health, and Safety 
Guideline for Semiconductor Manufacturing

EMC Standards

FCC CFR 47, Part 15, subpart B:2017, Class A
ICES-003, Issue 6:2016, Class A ITE
EN 61326-1:2013 - Electrical Equipment for measurement, 
control and laboratory use - EMC Requirements - Part 1: 
General requirements

Packaging ASTM D 4169 Standard practice for performance testing of 
shipping containers and systems

Pollution Degree 
Environment Pollution Degree 2

Indicator & Connector Specification
Voltage Input, RF RP-SMA, female (reverse polarized)
Current Input, RF SMA, female
Sensor Data Input 9-pin D-sub, male
Pulse Gate / Trigger Input

7001A900-2
7001A900-3

SMB, female
SMA, female

EtherCAT (7001A900-2 only) RJ-45 (x2) (Factory Diagnostic only)
RS-232 (7001A900-3 only) 9-pin D-sub, female
DeviceNet Lumberg RSWF5-PCB 5-pin circular (Factory Diagnostic only)
Ethernet RJ-45 (x1)
Status Indicators

 Receiver
 Ethernet
 DeviceNet
EtherCAT (7001A900-2 only)

Status (3 LEDs)
Link Status
Network & Module (Factory Diagnostic only)
Run, Link Activity x2, Error (Factory Diagnostic only)

Power Locking barrel, 0.080" pin dia.
Power Switch Rocker
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Optional Accessories

QC Connectors

Connector Description
4240-002 7/8 in. Swivel Flange EIA

4240-012 QC M-LT

4240-018 QC F-LT

4240-025 QC M-LC

4240-031 QC F-LC

4240-050 QC F-UHF

4240-062 QC F-N

4240-062-2 QC F-N, silver plated

4240-062-3 QC F-N, gold contact

4240-063 QC M-N

4240-063-2 QC M-N, silver plated

4240-063-3 QC M-N, gold plated pin

4240-075 QC F-LC bulkhead

4240-080 QC assembly, open terminator

4240-090 QC F-SC

4240-096 1-5/8, fixed flange EIA

4240-100 QC F-C

4240-110 QC M-C

4240-125 QC F-BNC

4240-132 QC M-BNC

4240-138 QC M-LC UG156A/U

4240-149 QC F-LC UG157B/U

4240-156 QC F-TNC

4240-160 QC M-TNC

4240-165 QC to QC adapter coupling block

4240-179 QC M-UHF

4240-180 QC coplanar connector

4240-187 QC 3-1/8 unflanged adapter

4240-194 QC 3-1/8 flanged adapter, 

4240-201 QC 7/8 in. adapter, 

4240-208 QC 1-5/8 swivel flanged EIA

4240-244 QC to QC right angle adapter
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4240-260 QC 1-5/8 in. flanged EIA adapter

4240-268 QC F-HN

4240-278 QC M-HN

4240-318 QC M-LC

4240-334 QC M-SMA

4240-336 QC F-SMA

4240-344 QC F-IEC 7/16 coaxial

4240-346 QC F-Mini UHF

4240-353 QC M-SC

4240-363 QC M-IEC 7/16, plug

4240-365 M-IEC 7/16 in., panel mount

4240-366 Socket, IEC 13/30

4240-370 QC M-SQS

4240-371 QC F-SQS

4240-372 QC M-SQS polarized

4240-373 QC F-QDS/UL

4240-374 QC M-QDS/UL

4240-375 QC F-SQS polarized

4240-376 QC F-QRM

4240-377 QC M-QRM

4240-378 QC M-QRM polarized

4240-400 Adapter kit, RF interseries
Includes 4240-402, 4240-403, 4240-404, 4240-405, 4240-406, 
4240-407, 4240-408, 4240-409

4240-401 Adapter kit, RF interseries
Includes 4240-402, 4240-403, 4240-404, 4240-405, 4240-406, 
4240-407, 4240-408, 4240-409, 4240-410, 4240-411

4240-402 M-N connector

4240-403 F-N connector

4240-404 M-BNC connector

4240-405 F-BNC connector

4240-406 M-TNC connector

4240-407 F-TNC connector

4240-408 M-UHF connector

4240-409 F-UHF connector

4240-410 M-SMA connector

Connector Description
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Mounting Hardware

Optional mounting flanges used to secure receiver. See "Installing the Receiver" on page 12.

Cable Sets

The three cables that carry voltage, current, and data from the sensor to the receiver are combined to form a 
molded cable set with three connectors on each end. These cable sets may be ordered in the lengths listed in this 
table.

 

Customer Service

Any maintenance or service procedure beyond the scope of those in this chapter should be referred to a qualified 
service center.
If the unit needs to be returned for any reason, request an Return Material Authorization (RMA) through the Bird 
Technologies website. All instruments returned must be shipped prepaid and to the attention of the RMA number.
Bird Service Center
30303 Aurora Road
Cleveland (Solon), Ohio 44139-2794
Fax: (440) 248-5426
E-mail: bsc@birdrf.com
For the location of the Sales Office nearest you, visit our Web site at:
http://www.birdrf.com

Part No. Description
5A2964-MF4 Mounting flange

Part No. Description
7001B040-2M BDS RF/Data Cable Set, 2m straight conn

7001B040-5M BDS RF/Data Cable Set, 5m straight conn

http://www.birdrf.com
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Chapter 6 RS-232 Serial Control

BDS receivers equipped with an RS-232 9-pin serial connector are capable of outputting measurement data over a 
serial data connection. The RS-232 interface conforms to the EIA/TIA-232E and ITU-T V. 28 specifications.
Prior to using this feature, the BDS receiver must be set up via the Graphical User Interface to measure frequencies 
of interest, see "Operating Instructions" on page 41. Once the Standard tracking options are selected, the 
ability to communicate with the BDS receiver via RS-232 must be enabled, see BDS Receiver GUI RS-232 
Settings below.

BDS Receiver GUI RS-232 Settings

Measurement Data Reporting Over RS-232

The BDS receiver will not acknowledge RS-232 commands unless data reporting via RS-232 is enabled on the Free 
Run Tab of Standard Tracking Options dialog. For RS-232 command and response messages, see "Measurement 
Reporting Command/Response Strings" on page 79.

Figure 73  Free Run Tab - Standard Tracking Options

Transient Detection Reporting Over RS-232

The BDS receiver will send a transient detection message if RS-232 transient detection reporting is enabled on the 
Transient Detection Tab of Standard Tracking Options dialog. For RS-232 transient detection reporting messages, see 
"Transient Reporting" on page 81

Figure 74  Transient Detection Tab - Standard Tracking Options
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RS-232 Serial Connection Settings

The device communicating with the BDS Receiver via RS-232 must be configured with the following settings.

 Speed: 115200

 Data: 8 bit

 Parity: odd

 Stop Bits: 1 bit

 Flow Control: none

Measurement Reporting Command/Response Strings

Prior to communicating over RS-232 serial bus with the BDS receiver, RS-232 data reporting must be enabled in the 
GUI, see "Measurement Data Reporting Over RS-232" on page 78.

Command

The commands available for RS-232 are shown in Table 7. For any command, data is only sent for the 
measurements that are configured in the GUI.
The format of an RS-232 command is SD\n\r.
Once a command is sent, the BDS receiver will respond with a response as shown in "Response" on page 80.
Table 7  RS-232 Commands  

Command Description
SD send all configured data.
SD1 send all configured data for 1st fundamental.
SD2 send all configured data for 2nd fundamental.
SD3 send all configured data for 3rd fundamental.
SD1H1 send the fundamental data for the 1st fundamental.
SD1H2 send the 2nd harmonic data for the 1st fundamental.
SD1H3 send the 3rd harmonic data for the 1st fundamental.
SD1H4 send the 4th harmonic data for the 1st fundamental.
SD1H5 send the 5th harmonic data for the 1st fundamental.
SD1X send all configured inter-mod data for the 1st fundamental.
SD2H1 send the fundamental data for the 2nd fundamental.
SD2H2 send the 2nd harmonic data for the 2nd fundamental.
SD2H3 send the 3rd harmonic data for the 2nd fundamental.
SD2H4 send the 4th harmonic data for the 2nd fundamental.
SD2H5 send the 5th harmonic data for the 2nd fundamental.
SD2X send all configured inter-mod data for the 2nd fundamental.
SD3H1 send the fundamental data for the 3rd fundamental.
SD3H2 send the 2nd harmonic data for the 3rd fundamental.
SD3H3 send the 3rd harmonic data for the 3rd fundamental.
SD3H4 send the 4th harmonic data for the 3rd fundamental.
SD3H5 send the 5th harmonic data for the 3rd fundamental.
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Response 

RS-232 Data Reporting is NOT Enabled in the GUI
A not acknowledged (NAK) response is sent by the BDS receiver if the SD command is sent but RS-232 data reporting 
is NOT enabled in the GUI. A definition of each response field in shown in Table 8 on page 80.

DS,NAK,DE\n\r   (11 characters total, including commas)

RS-232 Data Reporting is Enabled in the GUI
If RS-232 data reporting is enabled in the GUI, a complete data set is returned, after the Send Data command is sent 
to the BDS receiver. An example of a response data set is shown in Figure 75. A definition of each response field is 
shown in Table 8 on page 80.

Figure 75  Response Data Set

Table 8  Response Data Set - Field definitions

The responses are all fixed length in ASCII.

SD3X send all configured inter-mod data for the 3rd fundamental.

Field # of characters Contents Description
DStrt: 8 DStrt:\n\r Dataset start
DS 2 DS Data start
fnum 1 Integer Fundamental number (1,2,3)
hnum 1 Integer Harmonic number (1,2,3,4,5)
inum 2 Integer Intermod number (-3,-2,-1,00,01,02,03)
snum 1 Integer State number (1,2,3,4)
freq 9 Integer Measured frequency (Hz)
V 7 Float 4.2 Measured voltage (volts)
I 7 Float 4.2 Measured current (amps)
Ph 7 Float 4.2 Measured phase (degrees -180 to 180)
DE 4 DE\n\r Data end
DEnd: 7 DEnd:\n\r Dataset end
NAK 3 NAK Not acknowledged

MNE 3 MNE Measurement Not Enabled, if a measurement is 
requested that isn't configured in the GUI.

INV 3 INV Invalid, if an invalid command is sent.

Command Description
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Transient Reporting

A transient detection message (ARC) is sent by the BDS Receiver if a transient is detected and the transient detection 
reporting over RS-232 is selected in the GUI, see "Transient Detection Reporting Over RS-232" on page 78
The format of the transient detection message is shown below:

ARC\n\r

No additional information is reported with this message, to view the data associated with the transient detection 
refer to "Viewing the Data" on page 48.
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Limited Warranty

All products manufactured by Seller are warranted to be free from defects in material and workmanship for a period 
of one (1) year, unless otherwise specified, from date of shipment and to conform to applicable specifications, draw-
ings, blueprints and/or samples. Seller’s sole obligation under these warranties shall be to issue credit, repair or 
replace any item or part thereof which is proved to be other than as warranted; no allowance shall be made for any 
labor charges of Buyer for replacement of parts, adjustment or repairs, or any other work, unless such charges are 
authorized in advance by Seller.
If Seller’s products are claimed to be defective in material or workmanship or not to conform to specifications, draw-
ings, blueprints and/or samples, Seller shall, upon prompt notice thereof, either examine the products where they 
are located or issue shipping instructions for return to Seller (transportation charges prepaid by Buyer). In the event 
any of our products are proved to be other than as warranted, transportation costs (cheapest way) to and from 
Seller’s plant, will be borne by Seller and reimbursement or credit will be made for amounts so expended by Buyer. 
Every such claim for breach of these warranties shall be deemed to be waived by Buyer unless made in writing 
within ten days from the date of discovery of the defect.
The above warranties shall not extend to any products or parts thereof which have been subjected to any misuse or 
neglect, damaged by accident, rendered defective by reason of improper installation or by the performance of 
repairs or alterations outside of our plant, and shall not apply to any goods or parts thereof furnished by Buyer or 
acquired from others at Buyer’s request and/or to Buyer’s specifications. Routine (regularly required) calibration is 
not covered under this limited warranty. In addition, Seller’s warranties do not extend to the failure of tubes, transis-
tors, fuses and batteries, or to other equipment and parts manufactured by others except to the extent of the origi-
nal manufacturer’s warranty to Seller.
The obligations under the foregoing warranties are limited to the precise terms thereof. These warranties provide 
exclusive remedies, expressly in lieu of all other remedies including claims for special or consequential damages. 
SELLER NEITHER MAKES NOR ASSUMES ANY OTHER WARRANTY WHATSOEVER, WHETHER EXPRESS, STATUTORY, OR 
IMPLIED, INCLUDING WARRANTIES OF MERCHANTABILITY AND FITNESS, AND NO PERSON IS AUTHORIZED TO 
ASSUME FOR SELLER ANY OBLIGATION OR LIABILITY NOT STRICTLY IN ACCORDANCE WITH THE FOREGOING.
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